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Disclaimer of liability

The contents of this documentation have been carefully checked for consistency with the hardware and
software systems described. Nevertheless, it is impossible to completely rule out inconsistencies, so that we
decline to offer any guarantee of total conformity.

We reserve the right to make technical modifications of the systems.

Copyright

© 2025 imc Test & Measurement GmbH, Germany

This documentation is the intellectual property of imc Test & Measurement GmbH. imc Test & Measurement
GmbH reserves all rights to this documentation. The applicable provisions are stipulated in the "imc Software
License Agreement".
The software described in this document may only be used in accordance with the provisions of the "imc
Software License Agreement".

Open Source Software Licenses

Some components of imc products use software which is licensed under the GNU General Public License (GPL).
Details are available in the About dialog.

A list of the open source software licenses for the imc measurement devices is located on the
imc STUDIO/imc WAVE/imc STUDIO Monitor installation medium in the folder "Products\imc DEVICES\OSS" or
"Products\imc DEVICEcore\OSS" or "Products\imc STUDIO\OSS". If you wish to receive a copy of the GPL sources
used, please contact our tech support.
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Notes regarding this document

This document is an excerpt from the manual of imc STUDIO.

The manual for imc STUDIO is available both as an e-book and in PDF format. In the menu bar, click on the
symbol  to open the help.

The program "imc Help and Documentation" provides you with access to all formats and other documents such
as the device documentation or the technical data sheet.

What is the best way to read the imc STUDIO documents?

Getting Started

Before installing the software, start by reading the document "Getting Started". This contains important tips for
achieving problem-free installation, for updating the software, as well as for operation and integration of devices
in measurement setups.

All information presented in the document "Getting Started" is also presented in the imc STUDIO manual.

Manual - complete documentation

The manual serves as reference material. This document describes how to operate the software and how to
configure parameters for the devices. In some case, individual device groups have special functions. The
documentation for these usually appear exclusively in the device manuals.

Tutorials

Some chapters come with supplemental tutorials . We recommend practicing these tutorials as an
"accompanying" introduction to the respective topic.

If you are working for the first time with imc STUDIO, we recommend that you work through the guided first
steps  before beginning any tutorials.

Training programs for introduction to the systems, and advanced workshops

We recommend that before you begin working with imc STUDIO you participate in an extensive training session.
Such training will enable you to get started working efficiently much faster. Additionally, you will obtain valuable
tips and information on how to use the software more effectively. More information is available on our
homepage under "Service & Training" > "imc ACADEMY".

Special notes

Warning

Warnings contain information that must be
observed to protect the user from harm or to
prevent damage to property.

 

Note

Notes denote useful additional information on a
particular topic.

Reference

A reference in this document is a reference in
the text to another text passage.
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Before you start Chapter   1

1  General introduction

1.1  Before you start

Dear user.

1. The software you have obtained, as well as the associated manual are directed toward competent and
instructed users. If you notice any discrepancies, we request that you contact our tech support .

2. Updates during software development can cause portions of the manual to become outdated. If you
notice any discrepancies, we request that you contact our tech support.

3. Please contact our tech support if you find descriptions in the manual which you believe could be
misunderstood and thereby lead to personal injury.

4. Read the enclosed license agreement . By using the software, you agree to the terms and conditions of
the license agreement.

Note Notes on the descriptions and the screenshots

· The help may also contain parts shared imc software components. These parts may differ from the rest
of the help in terms of style and structure. All help files are equipped with a full text search functionality
and have an index.

· The screen shots appearing in this documentation were created with a variety of Windows versions and
their appearance may thus differ from that of your installed program.

· imc STUDIO works with user groups and access rights. The user group has wide-reaching influence on the
visibility and/or operability of menus, icons, etc. Note that in all imc STUDIO documents the administrator
roll is assumed to be filled. All descriptions are therefore related to the full utilization of the user
interface.

· The following descriptions and screenshots always pertain to the view with the full scope of functions
(Complete). Many of these functions are also found in the minimized view at another location.

1.2  Tech support
If you have problems or questions, please contact our tech support:

Phone: (Germany): +49 30 467090-26

E-Mail: hotline@imc-tm.de

Internet: https://www.imc-tm.com/service-training/

Tip for ensuring quick processing of your questions:

If you contact us you would help us, if you know the serial number of your devices and the version info of the
software. This documentation should also be on hand.

· The device's serial number appears on the nameplate.

· The program version designation is available in the About-Dialog (click on the symbol  in the menu bar).

6
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Product Improvement and change requests

Please help us to improve our documentation and products:

· Have you found any errors in the software, or would you suggest any changes?

· Would any change to the mechanical structure improve the operation of the device?

· Are there any terms or explanations in the manual or the technical data which are confusing?

· What amendments or enhancements would you suggest?

Our tech support  will be happy to receive your feedback.

1.3  Service and maintenance
Our service team is at your disposal for service and maintenance inquiries:

Phone: (Germany): +49 30 629396-333 (Mon.-Fri.: 9.00 - 12.00 and 13.00 - 17.00)

E-Mail: service@imc-tm.de

Internet: https://www.imc-tm.com/service

Service and maintenance activities include, for example calibration and adjustment, service check, repairs.

1.4  Legal notices

Quality Management

imc Test & Measurement GmbH holds DIN EN ISO 9001 certification since May
1995 and DIN EN ISO 14001 certification since November 2023. You can download
the CE Certification, current certificates and information about the imc quality
system on our website:
https://www.imc-tm.com/quality-assurance/.

imc Warranty

Subject to the general terms and conditions of imc Test & Measurement GmbH.

Liability restrictions

All specifications and notes in this document are subject to applicable standards and regulations, and reflect the
state of the art well as accumulated years of knowledge and experience. The contents of this document have
been carefully checked for consistency with the hardware and the software systems described. Nevertheless, it
is impossible to completely rule out inconsistencies, so that we decline to offer any guarantee  of total
conformity. We reserve the right to make technical modifications of the systems.

The manufacturer declines any liability for damage arising from:

· failure to comply with the provided documentation,

· inappropriate use of the equipment.

6
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1.5  imc Software License Agreement
imc Test & Measurement GmbH
Voltastr. 5
13355 Berlin, Germany 
Trade register: Berlin-Charlottenburg HRB 28778
Managing directors: Michael John Flaherty, Frank Mayer

imc Test & Measurement GmbH
Terms and Conditions

Governing the Use of imc Test & Measurement GmbH Software
As of: January 18th, 2024

§ 1 Objects of the Agreement

(1) In addition to the "General Terms and Conditions Governing imc Test & Measurement GmbH Deliveries and Services to
Customers", these terms and conditions apply to all contracts concluded with  imc Test & Measurement GmbH
(hereinafter referred to as "imc") which involve the transfer of rights of use to any software developed by imc (standard
software, software created or adjusted specifically for the Customer, which is recorded on the machine-decodable data
carriers such as data files, databases and database material, updates, upgrades, releases, etc., including corresponding
documentation, information and materials, hereinafter referred to as "Software").

(2) The Software is provided to the Customer as an executable object program on machine-decodable data carriers specified
in the "Objects of the Agreement". The Software's product documentation is also supplied to the Customer either in print
or on a machine-decodable data carrier. Unless otherwise expressly agreed in writing, the Customer is not issued the
source code of the Software.

§ 2 Rights of Use, Scope

With regard to any transfer of rights of use to Software created by imc, the following provisions apply:

(1) Basic provisions

 a) The Customer is granted a non-exclusive and – subject to the terms and conditions governing the use of Software by
third parties, resale and leasing – non-transferrable right of use to the Software for its own purposes. "Use" signifies
running the programs and editing the data records.

 b) Until each due fee is paid in full, the Customer is entitled to use the Software solely on a revocable basis. If the
Customer is in default with regard to the payment of fees, imc is entitled to revoke the use of the respective services
for the duration of the default. The Customer is granted the permanent right to use copyright protected services, in
particular the Software, only upon full payment of the agreed fee.

 c) The Customer agrees to undertake appropriate precautionary measures to prevent unauthorized access by third
parties to the Software. The original data carriers and the data carries used to make copies as per the agreement, as
well as the documentation, are to be stored in a secure location. Employees are to be notified that the production of
copies beyond the scope of the agreement is not permitted.

 d) If the right of use is revoked or expires due to another reason, the Customer is obligated to return to imc the
Software, the copies made by the Customer and the documentation. Provided that a physical return of the Software
and the copies is not possible due to technical reasons, the Customer is obligated to delete such and confirm deletion
to imc in writing.

(2) Reproduction

 a) The Customer is entitled to make copies of the Software only if copies are necessary to use the Software in
accordance with the contract. The following are considered cases in which reproduction is necessary: installation of
the Software from the original data carrier onto the hard disk drive of the hardware used, as well as loading the
Software into the computer memory. 

 b) The Customer is entitled to create a backup copy if such is necessary to safeguard future use. Copies may only be
made for other purposes after prior written consent has been issued by imc. 

 c) The Customer is not allowed to make any reproductions other than those expressly permitted under the provisions of
this agreement.
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(3) Use of the Software by Third Parties, Resale and Leasing

 a) The Software may be used for the purposes stipulated in this contract, in particular for the Customer's business
operations. Access to the Software may also be provided to parties which rely on using the Software as instructed by
the Customer. In particular, the Customer is entitled to operate the Software or allow the Software to be operated on
data processing devices, which are located on the premises of and are directly owned by a third party company
(outsourcing). The prohibition against multiple use remains unaffected. 

 b) The Customer may permanently sell or give the Software to third parties provided that the Customer is granted
permanent use of the Software. In the context of its period of use, the Customer may temporarily transfer the
Software to third parties for a fee or free of charge. The prohibition against multiple use remains unaffected. The
Customer is expressly notified that transfer to third parties is not permitted and use by third parties is technically not
possible if an individual license must be acquired or an individual activation is required for third party usage, such as in
the case of runtime licenses.

 c) With regard to the valid use of Software by a third party, the Customer is obliged to ensure that the third party
acknowledges the provisions of this agreement governing the rights of use as binding for such third party. The
Customer may not transfer Software and documentation to third parties if there are grounds to suspect that the third
party may infringe upon the provisions of this agreement governing the rights of use, in particular with regard to the
unauthorized production of copies. 

 d) Subject to the provisions stipulated in § 4 Paragraphs 1 and 2 or a deviating express agreement in writing, the
Customer may not use the Software while the Software is being used by a third party (prohibition against multiple
use); in the event that the Software is transferred to the third party, the customer is obliged to surrender to imc all
Software copies including, if applicable, all existing backup copies, or to destroy copies not surrendered.

(4) Decompilation

The reverse translation of the provided program code into other code forms (decompilation), disassembling and other
forms of reverse engineering of the various production phases of the Software is not permitted. If interface information is
required to achieve the interoperability of a separately created computer program, such may be requested from imc, or a
third party to be named by imc, for a minor fee. Section 69 e of the German Copyright Act ("UrhG") remains unaffected
by this provision.

(5) Changes by imc

If imc conducts adjustments, changes or enhances the Software on behalf and on account of the Customer, the Customer
thus acquires the corresponding rights of use to the changes or enhancements of the Software to which he is entitled
according to the stipulations of this agreement.

(6) Exceptional Usage Requests by the Customer

If the Customer requests to use the Software according to terms which deviate from the requirements stipulated in
Paragraphs 2 through 5, this exceptional use of the Software must be agreed in writing by imc. In such an instance, the
Customer agrees to provide imc with information about the desired scope of use, the pertinent field of application, etc. If
imc subsequently grants a license covering the Customer's special intended use, the parties agree that a new license fee is
owed by the Customer, which is independent of payments made by the Customer for the previously existing license.

§ 3 Copyright, Protection of the Software

(1) The intellectual property, in particular the copyright as well as all industrial property rights and trade secrets, are retained
by imc and are not transferred to the Customer. The Customer's ownership of the machine-decodable data carries and
data processing units remains unaffected.

(2) Copyright notices, serial numbers as well as designations and reservations of rights which serve as program identification
or a protective right may not be removed or changed. The Customer is obliged to transfer the existing protective right
notices to all copies. In particular, backup copies of the Software must be expressly designated as such.

§ 4 License Types, Multiple Use

(1) In the case of a Single-User License, the Software may be activated and run on only one data processing unit. "Activation"
refers to the process of transferring the license to the data processing unit.

If the technical specifications for the Software permit a second activation, then the Customer may additionally activate
the Software on a second data processing unit. However, the Software may only run on one data processing unit at any
one time, not on both simultaneously.
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(2) With a Network License, the Software may be run on as many data processing units as the amount of licenses obtained.
In this case a central data processing unit acts as the license server for which the activation process is performed.

If the technical specifications for the Software permit a second activation, then the Customer may additionally activate
and run the Software on as many data processing units as the amount of licenses obtained. However, these additional
data processing units must be used by the same users who operate the Software via the license server.

(3) Subject to the provisions in Paragraphs 1 and 2 or a deviating express agreement in writing regarding network use,
multiple use of the Software is not permitted.

(4) If the data processing unit is changed, the Customer is obliged to delete the Software from the hard disk drive of the
previously used hardware.

§ 5 Software-Subscription

If the Software used is a software-subscription, the following additional restrictions apply:

(1) The right of use is valid for a limited time period. The start and end of the time period are specified. After the end of the
time period, the right of use is expired.

(2) If the Customer wishes to continue using the Software after elapse of the specified time period, the subscription must be
renewed.

§ 6 Trial Version

If the Software used is a free trial version, then the following additional limitations apply:

(1)  The trial version only entitles the user to test the Software. In particular, commercially productive utilization is not
permitted.

(2)  The rights of use granted expire after the elapse of a period stated in the product description.

§ 7 License Key

(1) Upon delivery of the Software the Customer receives a License Key. Using this License Key, the Customer is able to
activate the Software purchased. By means of this License Key the Customer can also view his license status and order
updates and upgrades.

(2) The License Key is to be protected against access by third parties in order to prevent misuse. If, however, a third party
gains unlawful access to the Key, the Customer is obliged to notify imc immediately via telephone, as well as in writing, so
that the previous License Key may be suspended and a new one issued.

§ 8 Conclusion

(1) The law of the Federal Republic of Germany shall apply under exclusion of private international law. The provisions of the
UN Convention on Contracts for the International Sale of Goods (CISG) do not apply.

(2) The place of performance for all obligations arising from this agreement is imc's registered seat. Insofar as the Customer
is a merchant as defined by the German Commercial Code (HGB), a legal entity under public law, or a special asset under
public law, the exclusive place of jurisdiction for all disputes directly or indirectly arising from the contractual relationship
is agreed as imc's registered seat. The same applies to persons who have no general place of jurisdiction in Germany, as
well as to persons who have moved their place of residence or usual whereabouts abroad since conclusion of the
contract, or whose place of residence or usual whereabouts is unknown at the time the action is filed. In addition, imc is
entitled to file suit at the statutory venue.

(3) Oral side-agreements are not valid. Deviating or supplementary conditions as well as modifications of this contract,
including this written requirement clause, are only valid if agreed in writing and expressly marked as a modification or
supplement.

(4) If certain provisions of this contract are inoperative or unfeasible, this does not prejudice other provisions of the contract.
The contracting parties agree to contractually substitute an operable provision which approximates the commercial
intention of the contract as closely as possible for any inoperable one.
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 Chapter   2

2  Overview
This document describes the first steps in operating imc STUDIO and the installation of additional imc products.
This document uses textual references to the product documentation.

imc STUDIO is the common framework forming a product package through the combination of modular
components (plug-ins).

Which components are available depends on the product installation (order).

Chapter overview

Synopsis Section

Startup operations for imc STUDIO - installation and product
configuration prior to first use

· System requirements

· Installation / Uninstall

· Product Configuration / Licensing

· The first start

· Device connection / Network / Firewall

The first run - What steps are necessary in order to obtain
measured data?

· Training - Guided first steps

· Tutorials

The first steps in connecting with the device
· Setting Up - Connect the device

· Firmware Version

Data storage: How are data stored and loaded
· Experiments, Projects and the Database

· Ribbon "Project": Open / Save experiments

Navigation through the entire software
· Navigation Pane

The software user's interface is flexible. Saving and restoring
of views

· Saving / Loading views

Tech support

If you have any open questions about our products, please contact our tech support.

Questions or problems? Contact our Tech support .
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3  Setting Up - Software

3.1  System requirements

Supported operating systems

Windows 10*/11* (64 bit)

*released in conformance with the version of Windows 10/11
applicable at build date of imc software

Minimum requirements for the PC

4-core CPU 2 GHz 1

8 GB RAM (recommended: 16 GB RAM) 1

10 GB free hard disk space (recommended: SSD) 2

Display resolution: 1366 x 768 (recommended: 1920x1080)

1 Requirements and recommended minimum configurations for the applied PC will rise with increasing number of connected devices and
the resulting overall system data rate. Another crucial factor will be the extend of used live analysis and visualization functions on the
PC (in particular Data Processing, imc Inline FAMOS and active curve windows).
A smooth operation will also heavily rely on sufficient RAM memory resources on the PC: It must ensure to satisfy all vital functions
without any outsourcing to slow external swap file (HDD/SSD) in order to guarantee sustainable performance.

2 The hard drive memory requirement increases if measured data are saved to the PC.

Other operating system components

The following components are installed with the imc STUDIO setup if they are not already present:

Component Version Folder in "System" directory

Microsoft .NET Framework 4.8 DotNetFx4.8

Microsoft VC 2015-2022 14.38.33135 Microsoft Visual C++ Redistributable\2022

Microsoft VC 2010 10.0.40219.1 Microsoft Visual C++ Redistributable\2010

Microsoft Build Tools 2015 14.0.23107.10 MSBuildTools2015

Supported measurement devices

Which devices you can use in imc STUDIO is described in the documentation on the "Setup" > "Device Overview",
as well as in the "Technical Data Sheet".
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3.2  Installation - Preparation

Software requires a license

This means that the program may only be started upon obtaining a license (see Product Configuration /
Licensing ).

Administrator rights required

For the purposes of installation and uninstallation, a user account with administrator privileges for the PC is
required.

If you are logged on to the PC without administrator rights, log yourself out and log back on with an
administration-level user account. If you don't possess the appropriate account type, you will need the support
of your system administrator or IT department.

See also Notes on Windows User Account Control .

Restarting the computer in the process of installation

During the installation process, the installation program will prompt you to restart the PC.

Note Restarting

After the restart, login to the same user account with which you had previously begun the installation.

Coexisting applications: imc STUDIO, imc STUDIO Monitor, imc WAVE, ...

Some imc programs are installed as an independent and specially adapted instance of imc STUDIO. They are
based on imc STUDIO.

Unless otherwise stated, these programs are installed and used in parallel. As long as these instances are based
on the same version of imc STUDIO (e.g. 2022 R1), they are all subordinated to the same program installation,
which means they share resources.

For this reason, installation of the instances in this case must be performed in one
single shared Setup procedure. Any attempt to perform installation in succession or
subsequently will cause the already existing instances to be deleted.

This applies particularly to the joint and parallel installation of imc STUDIO Monitor,
imc WAVE and imc STUDIO, which must be performed in a single step.

Do not install
imc STUDIO, imc WAVE
and imc STUDIO Monitor
in succession, but always
at the same time.

Update or parallel installation

The Setup utility checks whether any version of imc STUDIO is currently installed on the computer. If so, it can be
uninstalled by means of the Setup. An associated confirmation prompt is posted in that case. All user data such
as the database remain intact.

The two versions can be installed in parallel provided that they have differing version numbers (e.g. 5.2 and
2023). The new version can be installed in the same folder (default case: "C:\Program Files\imc"). In this folder, a
new subfolder with the new version number is created for imc STUDIO.

In both cases, you are able to adopt a variety of settings from the old versions. These include the project
settings and views. By contrast, other settings such as the product configuration and the database path need to
be set up from the beginning.

25
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Adopting the settings with the help of the existing database (recommended)

When an existing database continues in use, any settings which can be retained will be retained. For a parallel
installation, two data bases are needed. Create a copy so that the old imc STUDIO version can continue to work
with the existing database. A confirmation prompt about making a copy is posted.
See: Update with the help of the existing database .

Adopting the settings without using the existing database

Some settings, e.g the views, can also be retained without the database. To do this, save and import the
appropriate settings.
See: Update without using the existing database .

The subsequent procedure - an overview

Follow the installation program instructions (see: "Installation step by step ").

· The installation process first checks whether the required system software is installed. If ones is missing, it
will be installed automatically.

· After restarting the system, the selected  products are installed.

· After the installation is concluded, it is possible to start imc LICENSE Manager directly to activate your
license.

· Once the license has been activated, imc STUDIO is ready for use.

Uninstalling

Un-installation is performed via the menu item "Windows-Settings" > "Apps & features".

Reference See also

· Recommended Virus Scanner Settings

· Changing Languages and Installing Additional Languages
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3.2.1  Update with the help of the existing database
When an existing database continues in use, any settings which can be retained will be retained. This includes
Views, any Setup-columns created by the user, the user administration and all experiments.

If you wish to run multiple versions of imc STUDIO or maybe restore an older version at a later time, create a
copy of the database.

Note The database

It is impossible to use the imc STUDIO database by both versions in parallel.

· If the same path is selected in the new imc STUDIO version, the database is used automatically. When
loading old experiments, a note is posted in the logbook that the experiments belong to an older version.
Once saved, they can no longer be loaded with the old version.

· If the database structure has been altered, you will be notified of this. A dialog for performing conversion
appears. This dialog can be used to convert the database and, if desired, copy it first. After the
conversion, the entire database can no longer be used with the old version.

Note Using new views

· Be aware that the new version provides new functions, such as new or enhanced Setup pages and new
menu items.

· Use of the new Views is recommended, in order for these new functions to be accessible! Please look
under "What's new" whether there have been any changes in this regard.

· User-made columns such as meta data columns are not automatically inserted into the pages. The
configurations of these columns, however, is adopted from the old View. You can re-insert these columns
at the desired position (by means of the Column Chooser).

· Multiple views are provided. Select a view and add whatever Setup pages are required or saved, and save
the view under a new name.

· How to save Views is explained in the section "Views ".

3.2.2  Update without using the existing database
In imc STUDIO, various settings were saved with the respective project and apply to
all the experiments it contains. Among other things, these include the view settings:
user-defined views, column configurations (e.g. metacolumns).

In order to retain these settings in the new version after having performed the
update without using the existing database, export of the settings are necessary.

Please first check which
settings you will need.

· If you wish to reuse all of the project's settings, export the project settings (by means of the Projects-
dialog: Menu ribbon: "Project" > "Manage Project").

· If you wish to reuse only the viewing settings, export the views .
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3.2.3  Notes and troubleshooting

Notes on Windows User Account Control

Do not change the user account

Example of  a password request.
Select "No".

With Windows, installation can be started without
administrator rights. In this case, the operating
system requires selection of a user account and
associated password, as shown in the example.

Do NOT continue with the installation
in this way, otherwise it will be
incorrect. Select "No".

Confirm the prompt by the user account control

Select "Yes", to start the installation.

When you are logged in to a user account possessing
administrator rights, you may receive a prompt by the
Windows User Account Control (UAC) to allow
changes. Select "Yes".
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Notes on the security software

Some virus scanners prevent correct installation of imc programs. We are currently aware of this affecting
products from the companies McAfee and ESET. In principle, almost any virus scanner can have settings
possibilities which prohibit necessary functions during installation.

For installation purposes, certain steps are necessary, such as:

· registration of programs for Autorun

· registration of programs as a service

· running of scripts from the TEMP-folder

· ...

The error profile may include various messages during installation. Or installed programs failing to launch.

In such cases, please contact your administrator to find out whether certain rules can be suspended for the
duration of the installation. For any further questions, please contact our tech support .

Reference See also

Recommended Virus Scanner Settings

3.3  Installation - Step by step
Actual texts appearing in the user interface may differ from those shown in the screen shots, depending on the
product configuration (path/version name).

Download and Installation

The most up-to-date version can be downloaded from the imc website under "Downloads" > "imc STUDIO". Both
a complete and a reduced installation package are offered. The reduced installation package is sufficient if you
have only purchased imc STUDIO. Which products are included is indicated next to the Download button.

Start the download first, and next the file (e.g. "Installer_imc_STUDIO_2024_R2.exe").

The Installer unpacks the installation files. Subsequently, it independently starts the actual installation. Select an
appropriate folder into which to unpack the files. The system's default suggestion is the Desktop.

Hinweis Installation files

The unpacked files can be deleted or saved once installation is completed. You can also use the unpacked
files for installation at a later time. You do not necessarily need the Installations-exe file. 

Installation language settings

Selecting the language during installation

After starting installation, a window appears in which
to select the installation language.

6
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Performing installation

Installation setup welcome page

The installation setup then starts in the language
selected.

Before starting installation

On the installation setup's next page, you are offered
the following choices:

· open the "Readme"-file,

· open the "Getting Started"-document,

· separate installation of imc LICENSE Manager and

· display of the installation medium contents.

License agreement

You must accept the license agreement to continue
the installation.
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Entering the installation path

The next step is to select the installation folder.
Under this folder, a separate subfolder will be created
for each imc product (e.g. imc STUDIO 2024). It is
recommended to end the associated pathname with
"\imc".

3.3.1  Select the products / Installation type

Now you can select which components should be installed. There are three types
available:

· "Full functionality for 30-day demo" : hereafter called "Demo"

· "Typical functionality incl. imc STUDIO Professional" : hereafter called "Typical"

· "User-def ined "

For the "Demo" and "Typical" installation types the installation settings are already
configured. If you need further settings choose the "user-def ined " installation
type.

"User-def ined" gives you
the ability to affect all
installation settings.

Installation type Beschreibung

Demo Use the installation type "Demo" in order to test the full scope of imc STUDIO and/or
imc WAVE for 30 days. No other products which require a password will be installed.

Typical Use the installation type "Typical" in order to install the Professional edition of imc STUDIO
including all necessary components. No other products which require a password will be
installed.

User-defined Use the installation type "User-defined" if you wish to configure the individual products.
With this type, it is possible to install password-protected components. Further, you can
install and configure additional imc products such as imc FAMOS.

Note that some components can require a separate license.

Note imc STUDIO reconfigure afterwards

Regardless of which variant of the installation is selected, when imc STUDIO is installed, all components are
included. This way, after successful installation it is possible to adapt the imc STUDIO configuration at any
time by means of the "product conf iguration " and to select the appropriate edition.
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Products
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Description

 ● : included ○ : optional

imc LICENSE Manager ● ● ● Managing the licensing (internal functions, does not appear in the list)

imc Shared Components
● ● ●

Proving common components of the imc products, such as the curve
window (internal functions, does not appear in the list)

Required system components ● ● ● System components require using of imc products.

imc SENSORS (1)

  ○
imc SENSORS is a database application for administering and editing sensor
information. Applicable with devices of the firmware group A
(imc DEVICES).

imc STUDIO Developer (Demo) (2) ●  ○ imc STUDIO is modular software platform handling all aspects of modern
measurement technology from simple data acquisition to sophisticated
test configurations.

imc STUDIO Professional (3)  ● ○

imc STUDIO any edition (3)   ○

imc STUDIO Monitor (3)

  ○

imc STUDIO Monitor makes it possible to connect with one or more
measurement devices, particularly for the purpose of monitoring the
instantaneous readings. Data can be viewed and edited live on multiple
workstations. It is based on imc STUDIO and is installed as a separate
instance of imc STUDIO.

imc WAVE (Demo) (2)
●  ○

imc WAVE is a software package for NVH (Noise Vibration and Harshness)
analysis. It is based on imc STUDIO and is installed as a separate instance of
imc STUDIO. It can be equipped with multiple, separately licensed
analyzers.

imc WAVE (3)
  ○

Firmware and driver package imc DEVICES
● ● ○

Package of device drivers and firmware required by imc STUDIO and
imc WAVE for devices of the firmware group A (imc DEVICES - e.g.
CRONOS family, C-SERIES, SPARTAN, BUSDAQ).

Firmware and driver package
imc DEVICEcore ● ● ○

Package of device drivers and firmware required by imc STUDIO and
imc WAVE for devices of the firmware group B (imc DEVICEcore - e.g.
ARGUSf it, EOS).

imc FAMOS Enterprise (Demo) (2) ●  ○
imc FAMOS is a program for analyzing, evaluating and documenting
measurement results.

imc FAMOS Reader (3) ● ● ○

imc FAMOS any edition (3)   ○

imc Format Converter ● ● ○ Converts imc measurement data to other formats such as EXCEL and ASCII.

imc Documentation
● ● ○

Installs the documentation on the selected products. If the checkmark is
removed, it is not possible to open the documentation via the software.

1: imc SENSORS requires a password for installation.

2: The associated Demo license must be activated after concluding installation by means of imc LICENSE Manager, otherwise it is not
possible to start the product. Once the demo trial period has elapsed, use the product configuration  to covert the product to the
license you have purchased.

3: The associated license must be activated after concluding installation by means of imc LICENSE Manager, otherwise it is not possible to
start the product.

When you select "Demo" or "Typical", the start of the installation follows immediately (see: "Starting the
installation "). By contrast, if you select "User-def ined", the installation is first configured .
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3.3.2  User-defined
The installation variant can be configured in detail. Based on your selection of components desired, different
installation steps are displayed.

Selecting components

Selecting User-def ined installation
 

Once you have selected the installation type "User-
def ined", it is possible to select/de-select the desired
products in the box at the bottom.

Required system components

Required system components (example)

In the next step, the system components which the
products selected require are displayed, along with a
note about which are already installed on your
system. It is also possible to re-install any already
installed components. Which components are
missing/present depends on the system and it update
status, so that the illustrations are intended as an
example only.

Configuring imc Shared Components

Conf iguring imc Shared Components

In this installation step, it is possible to install
password-protected components of
imc Shared Components.

Option/Component Description

COM Products The imc COM programming interface is a system integration tool 

Class Counting Kit Function library for imc COM products

Spectral Kit Function library for imc COM products
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Password for imc SENSORS

Password prompt for imc SENSORS

If you have selected imc SENSORS, you are prompted
to enter the password prior to installation. But if you
do not wish to install imc SENSORS, de-select it here.

Configuring imc STUDIO

Conf iguring imc STUDIO

It is possible to make settings for your licensed
product edition here. In consequence, later product
configuration  can be omitted.

Option/Component Description

Licensed edition Information on the editions is provided in the "Technical data sheet" for imc STUDIO.

Install additional languages With this option, imc STUDIO is installed in all available languages. (This will substantially
prolong the installation procedure).

Please be aware that some functions may require the other languages. For instance,
foreign-language parameter sets can only be imported if the associated language is
installed. 

If this option is deactivated, English language is installed plus the language of the operating
system, if available. If needed, all other available languages can be installed at a later time
(see the section "Installing additional languages ").

Create a shortcut on the
desktop

Program starting links can be created on the Desktop.

Explorer extension for data
in the device

Access to the device hard drive via the Windows-Explorer.

for devices of the firmware group A (imc DEVICES)

Service Service support. Install this component only if requested by our tech support.

for devices of the firmware group A (imc DEVICES) and group B (imc DEVICEcore)
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Configuring imc FAMOS

Conf iguration of  the imc FAMOS installation

In this step, you configure the imc FAMOS installation.
Select the editions you wish to install. Note that all
editions except the Reader-edition require a license.

Follow the Assistant's instructions and select your
preferred language for the help files and example files
like projects, sequences and dialogs. Select any
optional components which you wish to install along
with imc FAMOS. Additionally, a folder for sample
files is needed.

Reference imc FAMOS editions

More detailed information on the imc FAMOS editions is provided in the imc FAMOS manual.

Once all products have been configured, the installation can start.
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3.3.3  Starting the installation

Concluding the installation setup and starting installation

Before the installation, a system reboot is performed.
For this reason, first close any running programs
before continuing!

Confirm the reboot by means of the checkbox and
then continue (button: "Install"). Initially, the required
system components are installed. Subsequently, the
PC reboots automatically.

Warning Windows user account

After restarting, be certain to log in with the same user account with which you started the installation
process. Using a different user account can cause failure of correct installation of the components.

List of  components to install, following restart
(example)

After logging in, the actual installation of the products
begins. You are presented with a list of which
components are to be installed, which you can
confirm by clicking on "OK".

The figure shows an example; the actual dialog may
appear differently depending on your respective
previous selections.

Next, installation of the individual imc products begins.

Note Disabling the system start

While installation is running, the operating system is disabled from starting again, meaning that no other
programs can be started.

Concluding installation

When installation is finished, the following message is
posted.

Next, you can start imc LICENSE Manager in order to
activate your license. It is also possible to start the
imc LICENSE Manager later via the Start menu.
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3.4  Product configuration / Licensing
imc STUDIO can be ordered and licensed/activated in various product configurations. Further details can be
found in the order forms or on https://www.imc-tm.com. For a list of all possible editions and components, see
the "Technical data sheet" or contact our tech support .

Editions and components

The following editions are available for imc STUDIO, and each include a certain basic
package of components/functionalities.

Edition Order code

imc STUDIO Runtime imc STUDIO-RUN

imc STUDIO Standard imc STUDIO-STD

imc STUDIO Professional imc STUDIO-PRO

imc STUDIO Developer imc STUDIO-DEV

Additional optional or individually licensable components can also be integrated.

Each edition is able to apply configurations created with a higher edition, but not to
modify them.

With an appropriate
"Engine" activated, any
edition can run the
configurations of higher
editions.

For the Edition Standard, Professional or Developer, the corresponding license is required. These can be
activated in the imc LICENSE Manager. The Edition Runtime is a restricted version, free of charge. You can
register this edition in the imc LICENSE Manager. There, select the option "Trial versions and freeware".

Licensing (imc LICENSE Manager)

The software licenses are managed with "imc LICENSE Manager". After concluding installation, you can start
imc LICENSE Manager directly in order to configure your license (e.g. by means of the Windows Start menu:
group "imc" > "imc LICENSE Manager"). If imc STUDIO is started without an appropriate license having been
configured, the product configuration program opens, from where it is also possible to start
imc LICENSE Manager.

Follow the instructions of the imc LICENSE Manager. imc LICENSE Manager offers a separate documentation.
Start imc LICENSE Manager and click on "Help".

Changing the product configuration

You can change the product configuration in order to adapt it to the license purchased. For instance, if during
installation you have selected a different edition or if you have purchased a product upgrade. To do this, start
imc STUDIO and click in the menu bar (top right) on the symbol . The product configuration assistant now
opens. You can change the configuration to correspond to the licenses you have purchased. Follow the
instructions and close the assistant.

6
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Assistant for altering the product conf iguration

After completing the configuration, you must close and restart imc STUDIO to apply the new settings.

Changing the edition

In the dialog's upper region, a number of editions are available for selection. The
default selection is the edition currently being used. If you change the selection, you
can decide whether the available components are to adapt to the selection. In most
cases this is recommended, since this is the only way all of the edition's functions
will be available after an update.

Optional components are not affected by the edition selection and remain in their
previous state.

Please only change the
edition if you have
activated an appropriate
edition in the
imc LICENSE Manager.

Changing the components used

Additional components for the edition selected are available to choose. Some of these components require a
separate license.

In the bottom region of the dialog, the available components are shown. The set of components currently used
is selected by default (except subsequently to an edition change).

Column  Description

Aktive The component(s) is/are activated.

 The component(s) is/are deactivated

 Some of the components are activated. After clicking here, the components underneath are
deactivated.

Type The component requires an extra license in addition to the license for the edition.

 
 / 

The component can be activated for the selected edition without any additional license.

Name  Product name of the component

Description
 

Short descriptive text about the component. More detailed descriptions of the individual
components are provided in the technical data sheet.

Activate/deactivate the individual components in the column "Active".
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FAQ

Why are there sometimes two components for the same product? E.g. "Automation Editor" and
"Automation Engine"

Answer: Many components are subdivided into their actual function, on one hand, and on the other their
respective settings interface. This distinction exist for the following reason: each edition can run any
function created with a higher-level edition, but not modify it.

In other words, using the component "Automation Engine", you can run Automation-Tasks in the Standard
edition. However, the Editor ("Automation Editor") is only available in the Developer edition.

When should the "Engine" be deactivated

Answer: In most cases, it is not necessary to deactivate the engine if the component is not required.
However, be aware that every component activated makes resource demands.

At a minimum, keeping unnecessary components active slows down the launch of the system.

Disadvantage: All functions belonging to the deactivated components no longer work. Example
"Sequencer": Commands at Widgets, hotkeys/keyboard shortcuts, user-defined buttons, user-defined
events.

3.5  Start
Start the software by means of the associated desktop icon or via the Start menu.

Further, as part of installation an icon is set up on your desktop - depending on your choice during
installation .

If no icon was set up, then open the Windows Start menu. There you find the group "imc" and in it a
link to start the product.

If product configuration / licensing  is missing, the Product configuration starts automatic.

Splash screen

Next, a splash screen appears, indicating that software components are being
loaded. Depending on the installation and the PC capacity, this could take some
time.

Loading the software
components after start

17
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Homepage - Start page

By default the Homepage is shown when the software is started. The Homepage shows certain functions,
depending on the particular product, as buttons. Click on the corresponding buttons, to select your desired
functions. After the first installation, the "Homepage" may appear as shown in the example below:

Start page (example)

imc STUDIO starts with a simplified view

Along with installation of imc STUDIO, a number of Views are provided. Views in this sense are defined designs
for the user interface's appearance.

imc STUDIO offers a wide variety of possibilities and functions, but the entire scope of these is not always
needed for a single simple measurement.

Note imc STUDIO starts with a simplified view

In order to make it easier to get familiar with the software, the program starts with a simplified view with
limited choices: "Standard". All important functions for measurement and visualization of measured data
are available. The menu ribbon is structured in such a way that proceeding from left to right accesses all of
the Main windows .

Changing from the simplified view to View: Complete

You can switch to a different view at any time, in order to obtain access to all of the existing functions. To do
this, go first to the menu item "Extra" and in the drop-down list of views, select: "Complete".

Note Notes on the descriptions and the screenshots

The following descriptions and screenshots always pertain to the view with the full scope of functions.
Many of these functions are also found in the minimized view at another location.

29
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3.5.1  Device Connection / Network / Firewall

To use an imc measurement device, imc STUDIO must set up a connection via a network (mostly LAN). Details
on the network settings are presented in the chapter "Setting Up - Connect the device ".

Firewall

The firewall used might prevent establishment of a connection between the operating software and the
measurement device. If the software is unfamiliar to the firewall, then a corresponding prompt usually appears
upon accessing the network. This happens, for example, after starting the software and upon first accessing the
device (e.g. in a device search). Some firewall programs can also block access to system and hardware-
components.

In all cases, correct operation is only possible if the connection is not blocked. The following programs are
usually affected:

Program Default path

imc STUDIO: imc.Studio.exe C:\Program Files\imc\imc STUDIO...

imc DEVICES: imcDevices.exe C:\Program Files (x86)\imc\imc DEVICES...

imc DEVICES Service: imcDevicesService.exe C:\Program Files (x86)\imc\Shared

For operation on LAN, it is sufficient to enable "Private networks". Enable this access type. You may wish to read
the operating instructions for your firewall, and / or ask your administrator / IT-department.

Windows Defender Firewall: Unblocking is performed automatically upon installation.

3.5.2  Main Windows / Components
imc STUDIO provides the framework for various components. Components appear within imc STUDIO as
main windows. A component can have one or more main windows.

The main windows appear in the Navigation pane.

On the left you see an example of the Navigation pane with the main windows Homepage, Setup, Panel,
Automation and Sequencer (Panel is selected).

To jump to one of the main windows, click on the corresponding button in the Navigation pane.

Navigation pane : Select this link to go to further information on operation of the Navigation pane.

Note Notes on the use of the simplified view

· When you use the simplified view , the Navigation pane is hidden. In this case, in order to go to the
main windows Setup and Panel, use the menu ribbon.

· The other main windows can only be reached via the Navigation pane.

· If you need it, you can show the Navigation pane , or change the view .
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Tool window

Most components have their own tool window (e.g. the Panel with the tool windows: Widgets and
Data Browser). The tool windows are described in their respective sections.

Reference See also

Tool window : Select this link to go to further information on operating the tool windows and for a
description of the tool windows belonging to the imc STUDIO frame.

3.5.3  Important settings

User and User groups

imc STUDIO has the ability to administer various users which are permitted to use the program in various ways.
For details see the section "User administration".

Options

Before beginning to work with imc STUDIO, you can change essential settings, such as the folder path where the
experiments are saved.

You can change the folder path in the options (under "Project Management" > "HDD settings"):

Ribbon View

Extra > Options ( ) all

Note Reading and writing access rights are required

Please note that this setting will apply for every user of imc STUDIO. Each user must possess reading and
writing access rights for the specified folder path.

Checking and modifying the time zone

Applicable to devices belonging to the firmware group A (imc DEVICES): In order to assign a definitive point in
time for all measured data, a specific time zone is set for all imc devices used. The factory setting is
"UTC+01:00". If applicable, modify the time zone setting. For this purpose, the "Devices properties" dialog
contains an entry "Device time and synchronization" > "Time zone".

Ribbon View

Setup-Configuration > Device Properties Complete

100
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3.5.4  Command line parameters

Opening an Experiment file

An experiment file  (e.g. MyExperiment.imcstudio) can be opened directly in the Windows Explorer by double-
clicking. This starts a new instance of imc STUDIO and opens the experiment file. The same procedure also
applies for linkages to experiment files, for example files on the Desktop.

Experiments can be started with command line parameters. To do this, create a link to an experiment file and
enter the desired parameter.

["imc STUDIO-Installation"] "Experiment-File" [/fullscreen] [/do[StartMeasurement]]
[/do[StartSequencer]]

["imc STUDIO-Installation"] Open Experiment with a specific imc STUDIO installation (optional)

In order to open an experiment file with a particular installation of imc STUDIO, extend the link with the respective
installation's name. For example:

"C:\Program Files\imc\imc STUDIO 2023\imc.Studio.exe"
"imcDB://DB\StandardProject\MyExperiment"

The experiment file MyExperiment.imcstudio is started in the imc STUDIO  installation.

"Experiment file" Experiment to be loaded

Mandatory entry. Opens the experiment entered with the imc STUDIO  installation which is set up as the default
program under MS Windows. Mostly this is the last imc STUDIO version installed, or imc STUDIO Monitor/imc WAVE, if
this component was installed along with it.

One possibility is to specify the path in absolute terms:
"C:
\Users\Public\Documents\DB\StandardProject\MyExperiment\config\MyExperiment.imcStudio"

Another way is to specify it in reference to the name of the database and of the project (the appropriate database
folder must be selected):

"imcDB://DB\StandardProject\MyExperiment"

/fullscreen Fullscreen mode (optional)

In order to start an experiment in fullscreen mode, the experiment file is opened with the parameter /fullscreen.
"imcDB://DB\StandardProject\MyExperiment" /fullscreen

After opening the experiment file, the Panel is started in fullscreen mode, if the experiment contains at least one Panel
 page.

/do[StartMeasurement] Starting the measurement (optional)

In order to start the measurement automatically upon opening an experiment file, The experiment file is opened with
the parameter /do[StartMeasurement].

"imcDB://DB\StandardProject\MyExperiment" /do[StartMeasurement]

or
"imcDB://DB\StandardProject\MyExperiment" /fullscreen /do[StartMeasurement]

/do[StartSequencer] Starting the Sequencer (optional)

In order to automatically start Sequencer upon opening an experiment file, the experiment file is opened with the
parameter /do[StartSequencer].

"imcDB://DB\StandardProject\MyExperiment" /do[StartSequencer]

or
"imcDB://DB\StandardProject\MyExperiment" /fullscreen /do[StartSequencer]
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3.5.5  Error causes upon starting
Corrective actions for when the logbook opens with error messages directly upon starting imc STUDIO.

Message Corrective action

No matching DEVICEcore
found.

In the product configuration, the firmware imc DEVICEcore is activated. However, no
appropriate firmware has been found or installed.
By default all firmware products are activated. You can take the following corrective actions:

· install the appropriate imc DEVICEcore-firmware. This is only necessary if you wish to
use a device belonging to this firmware group.

· deactivate the component "imc DEVICEcore device adapter" in the product
configurator .

Error while initializing the
plug-in "imcDevices V2.x
Adapter" ...

In the product configuration, the firmware imc DEVICES is activated. However, no
appropriate firmware has been found or installed.
By default all firmware products are activated. You can take the following corrective actions:

· install the appropriate imc DEVICES-firmware. This is only necessary if you wish to use a
device belonging to this firmware group.

· deactivate the component "imc DEVICES V2.x Adapter" in the product configurator .

Could not load file or
assembly
'imc.Studio.Plugins.DevSet
up.Sensors.Stubs.dll' ...

In the product configuration, the component imc STUDIO Sensors is activated. However, no
appropriate imc DEVICES firmware was found or installed.
You can take the following corrective actions:

· install the appropriate imc DEVICES-firmware. This is only necessary if you wish to use a
device belonging to this firmware group.

· deactivate the component "imc STUDIO Sensors" in the product configurator .

The loaded Project-settings
are from an older
imc STUDIO version. If you
save these settings, an
older imc STUDIO version
would not be able to read
them correctly.

With every Version/Revision, new enhancements and other changes are introduced. In
consequence of these changes, some saved projects may become no longer compatible with
older versions.

Make sure that no older version of imc STUDIO needs to access the database.

More than one DEVICEcore
installation found in
STUDIO installation
directory.

Solution: Uninstall the older imc DEVICEcore version.

Could not connect to the
Guardian process. Some
functions (e.g. delete
measurements) will not
work.

The Guardian process is not running. Please start either the Guardian- or WatchDog-service.

For more info, see the section "Guardian"

25
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3.6  Training - Guided first steps

What steps are needed for obtaining measured data?

An Assistant is provided to help you become familiar with the system. The first steps – selection of the device,
channel configuration and display of the measured data – are usually identical.

Note

Restricted view

The Assistant is optimized for the Standard-view . It is also possible to start the Assistant in the
"Complete" view. This omits the highlighting of some elements.

Product configuration

Before starting the Assistant, modify your product configuration . For instance, if you have activated
imc Inline FAMOS, additional steps will appear.

Start the Assistant from the homepage directly after starting imc STUDIO. Click on "Let's go" ①. You are able to
start and repeat the Assistant again at any time.

Starting the Assistant
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A dialog appears, in which the next steps are explained to you. As an aid in orientation, a pulsating circle ②
appears in the imc STUDIO user interface in order to highlight the interface element with is the topic of the
descriptive text. As shown in the example below, the next step is to open the Devices list. To do this, it is enough
to click on the button "Setup" in the menu ribbon. The Assistant recognizes when the assignment has been
completed, and only then enables the "Next"-button ③.

The Assistant provides guidance using graphical highlighting and inforative texts

By means of the tabs, you can repeat or skip steps.

Each page contains a link to the pertinent section in the user's manual, where you can find advanced
descriptions of the respective pages and steps.

Note Firmware and network configuration

If the device's firmware is either wrong or the device cannot be found, then please see the section "Setting
Up - Connect the device ".

Reference Tutorials

Once you have worked through the first steps, we recommend you follow the Tutorials . Here you will
receive helpful tips and learn about additional operation possibilities.
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3.7  Info / Version information

imc STUDIO consist of multiple components. In order to see which components are included in your package,
click in the menu bar on the symbol . Then a pop-up window appears displaying the product names and
details on the components:

Version information (example)

With the buttons on the left side ①, you can change
the list's depth of detail and how it is sorted.
Additionally, you will receive all copyright notes
regarding "Open source software" ( ) ②.

With the buttons on the right side, you can start the
assistant for the product configuration  ③, start
the imc LICENSE Manager  ④ or export the
product selection ⑤.

While performing the export, you can save the contents as a file in XML format. For inquiries to our tech
support, it may be necessary to send it as an e-mail (see also section "Tech support ").

25
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3.8  Information and tips

3.8.1  Changing languages and installing additional languages
Following installation, imc STUDIO is available in English and, if applicable, in the language of the operating
system. Additional languages can be installed by selecting the option "Install additional languages" in the
installation variant "User-def ined ".

Note Observe operation system settings

· Please ensure that your operating system is set correctly to the display language. Some languages require
modifications to be made accordingly. In particular, the "System locale" must be set correctly to
correspond with the display language.
Otherwise, with some languages there can be problems with the characters. Languages affected include
Japanese, Chinese, Russian, ...

· Mixed language settings for the format in Windows cause problems with the display of units with special
characters: see Ribbon "Setup-Configuration" > "imc CANSAS Software"

Changing the language

By default, the imc software will start in the same language as the Windows version installed. If this language is
not supported, then the English program version appears.

The language can be changed, irrespective of the Windows version. Use the program "imc Language Selector".
The program is found in the Start menu under the group "imc".

Note Constraints

Only the imc software's texts are converted. Components which depend on the operating system's
language setting are not affected.

Please only use one of the following two languages:

· Default: the operating system's language

· English

Any other selection may cause malfunctioning if the operating system and the imc programs use different
languages.

21
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Installing additional languages

If desired, all other supported languages can be installed later (no installation medium is required).

Note Which languages are be installed subsequently

In subsequent installation of languages, all languages supported are installed. There is no selection
possibilities.

Step by step

· Administrator rights are required.

· Open the  installation folder of imc STUDIO (e.g. "C:\Program Files\imc\imc STUDIO..."), e.g. with Windows
Explorer or by means of the command line.

· There, open the folder "Languages"

· Run the file "InstallLanguages.bat".

· Wait until the script stops and posts the message "Failures: 0". This indicates that the installation has
completed successfully.

Note Instruction notes

If installation was unsuccessful, the necessary user rights may be missing:

· If "InstallLanguages.bat" is called via the command line, run the command line as Administrator
(context menu: "Run as Administrator")

· If "InstallLanguages.bat" is called via the Windows Explorer, run the call as Administrator (context
menu: "Run as Administrator")

3.8.2  Recommended virus scanner settings
The presence of many channels can burden the PC if a virus protection program scans the data captured. This
may cause a jiggling display and high demands on the processor.

We strongly recommend removing imc STUDIO from the virus scan. Most virus protection programs are able to
classify individual programs as low-risk. To do this, please refer to the instructions for your virus scanner.

Low-risk Default path

Add the programs imc.Studio.exe, imc.Monitor.exe and
imc.WAVE.exe to the list of low-risk programs

C:\Program Files\imc\imc STUDIO...

Add the program imcDevices.exe to the list of low-risk
programs

C:\Program Files (x86)\imc\imc DEVICES...

Add the database path along with all subfolders to the list of
low-risk folders

C:\Users\Public\Documents\DB

Ensure that its data are not searched for viruses during reading or writing.

Reference Installation

See also the installation note: "Notes on the security software "17
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3.8.3  Enhanced installation

Installing projects

You can prepare projects which are automatically included with the installation. E.g., after the installation,
special views and experiments will already be available.

· Create a project-export-file (".imcStudioExport") for the purpose. Make sure
that the project is exported and not only the experiments (selection). Upon
exporting, you can define what the file is to contain. E.g., only the project
settings, or also the experiments.

· Save the file(s) on the installation medium in the following path:
..\Products\imc STUDIO\Projects

Produce an installation medium and run the installation as usual or install from the
hard drive.

After the first launch of imc STUDIO, projects are imported into the database.

Any existing projects
having the same name
will be overwritten.

FAQ

Question Answer

What happens if the project exists already? All project settings will be overwritten.

What happens if the project has contents which do not
exist in the project to be imported?

All content besides project settings remains intact.
E.g. experiments, measured data, metadata, ...

What happens if the project has contents which already
exist in the project to be reported?

These will be overwritten. As well, any experiments,
measured data, metadata, ... are overwritten.

What happens if there are any other projects present? These projects remain intact.

What all is imported from the project?
All project settings and any experiments, measured
data, metadata, ... the projects contain

Adding your own personal programs

On the installation medium, in the folder "Products", create an extra folder for your own product. Save your
installation file there. The Installer will now automatically detect the product and offer it for installation.

Optional: By means of an ini-file, you can cause your product to be the default selection in the Product-Selection
list.

On the installation medium (on the same level as the folder "Products"), create an additional folder named
"Configuration". There, create a file named "Setup.ini". Fill this file with the following text:

[SetupX]
SetupX1=<PRODUCT>

For <PRODUCT>, insert the name of the folder in which your installation file is located.
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3.8.4  Unattended installation - Silent installation
For unattended installation ("Silent installation"), certain parameter files (.ini) are required. Create these files by
means of a command line call.

Setup.exe /CREATEINIFILES="<TargetPatch>"

To do this, proceed as follows:

· Start the installer - e.g. "Installer_imc_STUDIO_2023_R2_2023-04-20.exe".

· The installer begins by unpacking the content of the installation medium. Select an appropriate target
folder on your hard drive: e.g under "C:\DVD\".

· As soon as the unpacking process has concluded, configuration for the installation begins. Cancel this
procedure!

· Start Windows' command prompt ("cmd", "command shell").

· Navigate to the appropriate file path and call the Setup with the following command line (in the example
here, the folder is: "S:\DVD\"):

Setup.exe /CREATEINIFILES="C:\DVD\"

The frame setup is started and may be configured as desired. When the settings are finished being made, there
is no restart, as there usually would be. Instead, at the specified target location, *.ini-files are created which
have the following structure:

Main file

DVD/Configuration/Setup.ini

Product files

DVD/Products/$Productname$/Configuration/$Filename$.ini

z.B.

DVD/Products/imc STUDIO/Configuration/imc STUDIO.setup.ini

DVD/Products/imc FAMOS/Configuration/Setup_imcFamos.ini

The ini-files contain the settings which have been made.

Subsequently, the DVD folder can be copied to a data carrier and used for the unattended installation.

Calling the unattended installation

The installation process is called with command line parameters, where "/SILENT" causes the silent setup
installation to start. The following is an example of a 64-bit system:

DVD/Setup.exe /Lang=en /DIR="C:\Program Files\imc" /SILENT

With the additional parameter "/UNINSTALL=ALL"  all previous versions are removed.

If the switch is set to "NECESSARY" only the necessary version are de-installed. When setting the switch to
"NONE", no version is removed.

In special cases a de-installation is needed, e.g. if you install the 5.2 R23 to a 5.2 R22.  The 5.2 R22 needs to be
de-installed.
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Note

Creating ini-files in a different folder

You can also create the ini-files in a different folder. In this case, merge the two folders afterward (not
recommended because prone to errors).

Please always create new ini-files each time

With any new version, it may occur that new keys are entered in the ini-files. For this reason, create new
ini-files for any new version.

3.8.5  Different editions installed on one single PC
In some cases, it is helpful to be able to switch between two editions without having to adjust the product
configuration; for example, between imc STUDIO Developer and imc STUDIO Runtime.

This is not possible directly and requires some manual adjustments.

The configuration is stored in the application folder. You can duplicate the folder and create another
"application" with a customized configuration.

Warning Changes must be maintained twice

All settings made in the application must then be maintained twice. Or be replaced in each case.

Follow these steps:

· Duplicate the application directory: e.g.
C:\ProgramData\imc\imc STUDIO\Applications\_1_Copy

· Modify the shortcut inside and copy it to the desktop.

The shortcut must call imc.Studio.exe with the parameter -a and the new application folder. For example
"C:\Program Files\imc\imc STUDIO 2023\imc.Studio.exe" -a "C:\ProgramData\imc\imc
STUDIO\Applications\_1_Copy"

The new shortcut now starts an application "_1_Copy" which is independent from "_1". Both can be configured
separately.
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4  Setting Up - Connect the device
There are multiple ways to connect the imc measurement devices with the PC. In most cases, the connection
via LAN (local area network, Ethernet) is implemented. See section "Connecting via LAN in three steps " for
the quickest way to connect PC and measurement device.

But there are also other connection types:

· WLAN

· LTE, 4G, etc. (via appropriate routers)

These are described in a separate section: "Special options for connecting to the device".

The devices use the TCP/IP protocol exclusively. With this protocol, some settings and adaptations for your local
network may be necessary. For this purpose, the support of your network administrator may be necessary.

Note

When using multiple TCP/IP connections, e.g. LAN, WLAN and modem, observe the remarks in the section
"Computers with multiple TCP/IP connections".

Recommended network configuration

The latest and high-performance network technologies should be used to achieve the maximum transfer
bandwidth. This means especially 1000BASE-T (GBit Ethernet). GBit Ethernet network devices (switches) are
downward compatible, so that imc devices that only support 100 MBit Fast Ethernet can also be operated on
them.

The cable length between the switch and a PC or a device should be less 100 m. Use a shielded cable. If the
length of 100 m is exceeded, then you have to insert another switch.

If the system is being integrated into an existing network, you must ensure that the minimum data rate can be
guaranteed. Under some circumstances, this may require using switches to subdivide the network into separate
segments in order to govern the data traffic in a targeted way and thus optimize the data rate.

In very demanding applications, you might consider grouping multiple GBit Ethernet devices via even higher-
performance sections lines of the network (e.g. via 5 GBit Ethernet) and to connect these groups to
NAS-components, for instance, via these lines.

When such imc devices are included which use network-based PTP-synchronization (e.g. CRXT or CRFX-2000GP),
then it is necessary to use network switches which fully support this protocol on the hardware side. Appropriate
network components are also available as imc accessories (e.g. CRFX/NET-SWITCH-5) and are then electrically
and mechanically fully compatible with the imc systems.

42
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4.1  Connecting via LAN in three steps
The most common case is described below: the PC and the device are connected via cable or network switch.
The device's IP address must be set in the PC's address range. Subsequently, the device can be connected with
the PC. If a connection has ever been established previously, the software recognizes the device's hardware
configuration. In that case, experiment configurations can be prepared without any connection to the device.

Step 1: Connecting the measurement device

To connect via LAN there are two options:

1. The measurement device is connected to an existing network, e.g. via network switch. Only with a switch
is it possible to run multiple devices.

2. The measurement device is connected directly to a network adapter on the PC (point-to-point).

In a LAN, the first case is typically implemented. Modern PCs and network switches are usually equipped with
Auto-MDI(X) automatic crossover recognition, so that it is not necessary to distinguish between crossed and
uncrossed connection cables. Thus both cable types can be used.

Step 2: IP-configuration

Start imc STUDIO. Click the "Device interfaces" button  ( ) to open the dialog for configuring the IP address of
the device.

Ribbon View

Setup-Configuration > Device interfaces ( ) Complete

If this button is not present in the view, it is also possible to open the dialog after a device search if it failed to
find any new devices. Subsequently, a prompt appears asking whether to search for devices with an
inappropriately configured network interface. Close this message box by clicking "Yes".
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Once the dialog starts, the system automatically searches for all devices in the
network. In the tree diagram, all available devices are indicated. If the device
appears among the group "Currently not reachable" ①, it is necessary to modify
the device's LAN-settings. If the device appears among the group "Ready for
measurement" ②, you can leave the settings as they are or review them.

Select the device for making modifications ③.

If there is any IP-conflict,
devices affected will not
be listed.

Display of  measurement devices found and of  the IP address

Set the IP address manually if you are not using DHCP. The device's IP address ⑤ must match with the PC's
address ④. To conform to the network mask, only the device portion may be different (see example).

Example

In the example shown, the fixed IP 10.0.11.75 with subnet mask 255.255.255.0 is selected for the PC. For
measurement devices, any numbers would be suitable which begin with 10.0.11. and then do not contain 0,
75, or 255. The 0 and the 255 should not be used, if possible, due to their special significance. The 75 is the
computer's number.

Example for IP settings PC Device

IP address  10  .  0  .  11  .  75  10  .  0  .  11  .  86

Network mask 255 . 255 . 255 . 0 255 . 255 . 255 . 0

If the configuration type: "DHCP" is used, the IP address is obtained automatically from the DHCP-server. If it is
impossible to obtain any setting values via DHCP, the alternative values are used. These could lead to errors in
the connection (different networks, same IP addresses, etc.).
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If there is a direct connection between the device and the PC by a cable, then DHCP should not be used.

In order to apply the changes, click on the button "Apply". Wait for the device to restart and then close the
dialog.

Note Connection via modem or WLAN

For devices of the firmware group A (imc DEVICES):

If the connection to the device is established via a modem or WLAN, start the program "imc DEVICES
Interface Conf iguration" by clicking on the button: "Advanced Configuration" (see previous figure). An exact
description is found in the software manual chapter: "Setting Up - Connect the device" > "Special options for
connecting to the device".

Step 3: Integrating a device into an experiment

Now you are ready to add the device to the imc STUDIO experiment. If your device is unknown to the system,
first perform the "device search".

Ribbon View

Home > Search for devices ( ) all

Setup-Control > Search for devices ( ) Complete

Select the desired device: Once you click in the checkbox "Selected" for the desired device, it is ready to use in
the experiment (see Device Search - Known and Selected).

You can also select multiple devices for your experiment.

Now the device is "known". After the next program start it is available for selection. For further information, see
the documentation on the component "Setup".

Reference Time zone

Now check whether the correct time zone is set for the device: see "Important settings ".30
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4.2  The network

Optimize the network

You should observe the following notes for networks with high data rate, to reduce the risk of a data overflow.

1. The network between switches and PC should be 1GBit/s

2. The actual data rate is decreasing with the number of channels. Avoid unnecessary channels.

3. The RAM buffer should be as big as possible, not "Auto".

4. Save only channels you need to the internal disk.

5. Avoid curve window setting that need a lot of performance. Choose scroll mode. Avoid the rezoom
function after a long measurement duration. Don't set the sample points to symbols. Try to find a curve
window configuration, that shows no bucking.

6. Observe the recommended virus scanner settings ! It would check every sample  written to the hard
drive. That takes most of the performance of a PC and the hard drive.

7. Check the processor and network load with the PC task manager

Using a second network

To avoid disturbing data transfer between devices units and PC's, a second network using a second network card
per PC can be set up. This second network can be used for transferring data between the PC's.

Example of a Complex Network

Until now, we have only considered networks consisting of a PC and n imc devices units. However, any arbitrary
combinations are possible.

Monitoring

The PC on which imc STUDIO is installed is declared as
the Master-PC, which configures the measurement
device.

For devices belonging to the firmware group A - e.g.
CRONOS family, C-SERIES, SPARTAN, BUSDAQ:

Various other clients can access the measuring
device via the network (e.g. via imc STUDIO
Monitor or imc LINK or, it is set up accordingly,
using a browser via imc REMOTE WebServer).

The well-known network restrictions are also valid here. In particular, it is impossible for more than one person
to write to the same file. Furthermore, it is impossible for one person to open a file while another writes to it. In
general, all network restrictions that apply to files also apply to the individual Devices units.

In consequence, the software con prevent multiple users from configuring the same device.
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4.3  Firmware version

imc DEVICEcore and imc DEVICES as a driver package for imc STUDIO

The drivers and firmware components for imc devices are provided in "imc DEVICEcore" and "imc DEVICES".
Thus, at least one of the two driver packages is a necessary requirement for operating imc devices under
imc STUDIO.

· imc DEVICEcore:  For devices belonging to the firmware group B  - e.g ARGUSf it, EOS

· imc DEVICES: For devices belonging to the firmware group A - e.g. CRONOS family, C-SERIES, SPARTAN,
BUSDAQ

Both packages can be installed and operated in parallel. The software and the devices automatically apply the
appropriate package.

The software only works with devices having the right firmware. Upon the connection/preparation, the versions
are compared. If they don't match, the firmware update  is carried out.

Note Parallel firmware versions

imc DEVICEcore: The associated firmware- and driver package ships with the software used, and is installed
in the software's installation folder. Any other installations are not recognized and thus cannot be used.

imc DEVICES: It is possible to work with multiple groups of imc DEVICES simultaneously and in parallel. In
special cases, this may be relevant or even recommendable, particularly in conjunction with the use of
multiple devices. Additional notes on this subject are provided in the chapter: "Associated Firmware
(imc DEVICES) "

4.3.1  Firmware update

Every software version comes with matching firmware for the hardware. The software only works with devices
having the right firmware.

Once the program connects up with the unit, the device's firmware is checked. If the software version doesn't
match the device's firmware version, you are asked if you want to perform a firmware-update.

Note

The firmware update is only required if the software was obtained as an update. If you obtained your
hardware equipment together with the software, no firmware update is necessary.

Warning Do not interrupt the firmware update!

Be absolutely certain to observe the following:

1. Under no circumstances should the device or its power supply be deactivated during the firmware
update!

2. The network connection may not be interrupted. Use a cable connection, not WLAN!
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Firmware update - imc DEVICES

Note Firmware and driver package

The following description applies to devices of firmware group A (imc DEVICES) - e.g. CRONOS family,
C-SERIES, SPARTAN, BUSDAQ.

Depending on the device type, the following components are loaded automatically: Interface-firmware
(Ethernet, modem, ...), booting program, amplifier firmware, firmware for the signal processors.

The dialog for the firmware-update looks like this:

Start of  the f irmware update (example of  a single device)
The state of  the components of  the f irmware is diaplayed in the list.

Component Description  

Interface Interface-Firmware (Ethernet)  

Booter Start-up program for the device upon switching-on  

Operating system Device operating system  

Online Online-functions and hard drive controller  

Display Operating system of the connected displays  

Fieldbus Fieldbus interfaces (e.g. CAN etc.)  

Signal conditioners Amplifiers  

The following symbols for the individual firmware components appear in the list:

Symbols  

not current  

firmware conforms to current standards  

error occurred during update procedure  

— this option is not available on the device  

If no status indicators are displayed, no connection could be made to the corresponding device.

The duration of the update depends on the number of amplifiers (can last up to several minutes). You will be
informed on the progress.
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You are notified when the firmware setup concludes successfully, as shown below:

Conclusion of  the f irmware update (example of  a single device)

Choose "Close". The device can now be used with the product software.

Warning Be sure to observe in case of error

· For a variety of reasons, the firmware update sometimes does not conclude properly, for example due to
interruption of the power supply. For instance, the "handshake signal" at the end of the procedure may
be missing. In this case, no measurement channels would be displayed initially. However, restarting the
device and its software and performing the firmware update again usually restores everything to normal.
It may be necessary to call the menu function "Update all components" in the Firmware update dialog's
Options menu. This scenario only results in permanent damage in the most rare cases, and it is very
worthwhile to repeat the procedure before sending a device in for repair.

· Behaviour under error condition, Windows cuts off the network connection without the user's
knowledge; but this can be prevented using the PC's Control Panel.
Background: During the firmware updates there is no data transfer for a few minutes and thus no
network activity; Windows detects inactivity of the connection and the following mechanisms are set in
motion:

a) Windows' energy saving mode switches the LAN adapter off, consequently interrupting the network
connection!

b) Windows switches to the next LAN adapter if there is one (some PCs have multiple adapters in order
to, for instance, to access services in parallel that are accessible via separate networks.)

c) Other scenarios are feasible, e.g. if switches are activated, which can also respond to missing data
traffic.

If an error message is posted during the firmware update, leave the device on and contact our tech
support . The firmware update may be continued with guidance from the tech support.

Note

Firmware logbook

The "File" menu offers a function for working with the firmware log file. Every action taken during a
firmware update plus any errors which may occur are recorded in a log file. This log file can be displayed
with menu "File" > "Show log f ile".

6
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Firmware update - imc DEVICEcore

Note Firmware and driver package

The following description applies to devices of firmware group B (imc DEVICEcore) - e.g. ARGUSf it, EOS.

Upon the connection/preparation, the versions are compared. If they do not match, the next dialog notifies you
about this, and indicates both which version is being used and which version is required.

When you click "Yes", the firmware update starts. The duration of the update depends on the number of
amplifiers (can last up to several minutes). You will be informed on the progress.

If the firmware update was successful, the dialog will close automatically after a few seconds. Subsequently the
device can be used with the device software.

FAQ

What to do in case of an error occurring in a firmware update?

Answer: When a firmware update fails to run correctly, the last active firmware is restored. The device
remains operational by means of the previous installed firmware. Repeat the procedure, and if the repeat
procedure also fails, please contact our tech support.

What is an optional update?

Answer: In some cases, a firmware update is not mandatory. In such cases, the update is available to you as
"optional". However, we still recommend performing the update, since every update not only implements
improvements, but also fixes any bugs. Nevertheless, with the new version of imc STUDIO, you are able to
work with the device running the old firmware edition, if you choose.
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4.3.2  Associated firmware (imc DEVICES)

If multiple firmware versions are installed on the PC, then a defined version must be selected for each device.
The selection strategy is set in the Options: "Setup" > "Device options" > "Selection of  the imc DEVICES version".

Ribbon View

Extra > Options ( ) all

Option Description

Selection of the
imc DEVICES version

If multiple imc DEVICES versions are installed on the PC, a specific version must be selected
for the operation of each device. This option controls the selection strategy.

If only one imc DEVICES version is installed, this setting has no effect.

· Manual:  With "Manual", the system always asks which firmware version to use when
device are selected or an experiment is loaded.

· Automatic: "Automatic" avoids firmware updates. The version currently running on
the device is used preferentially.

· Always use latest: With this selection, the most current firmware version compatible
with this imc STUDIO version is always used.

Note Use of older firmware

Please note that a new firmware version not only contains new functions, but also reflects resolved issues.
These changes only take effect if the device is also using the new firmware.
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FAQ

Question: Which firmware versions support my imc STUDIO version?

Answer: In regard to the use of imc DEVICES as the device driver, there is a clear distinction determining the
compatibility of versions/version groups:

imc STUDIO version assigned firmware / version group additionally compatible

5.2 2.10, 2.11, 2.13  

2022 2.15 2.14

2023 2.16 2.14, 2.15

2024 2.17 2.14, 2.15, 2.16

... ...  

For version 5.2, the applicable rule is: the assigned version group and all predecessor groups going back to
2.10 are compatible with the imc STUDIO-version used.

As of version 2022, the applicable rule is: the assigned version group and all predecessor groups going back
to 2.14 are compatible with the imc STUDIO-version used.

Question: Can devices in the same experiment use different firmware versions?

Answer: Yes. If multiple devices are used, each one may use a different firmware version. Prerequisite: The
imc STUDIO-version used supports the firmware versions.

Question: Can I install a new firmware version without changing the imc STUDIO version?

Answer: Yes. Prerequisite: The imc STUDIO version used supports the firmware version.

Question: Is there a way to determine what firmware the device is using?

Answer: Yes.

· On the Setup page: "Devices", a column can be added: Device firmware

· In the Device properties.
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5  Tutorials

Guided first steps

If you are working for the first time with imc STUDIO, we recommend that you work through the guided first
steps  before beginning any tutorials.

There is an assistant which helps introduce you to the program. The first steps – device selection, channel
configuration and displaying of measured data – are usually identical.

Tutorials

The following are tutorials on device configuration and measurement data display.

· Simple measurement - First steps

· Circular buffer memory for the display

· Subsequent saving of measured data

· Simple triggering

· Simple triggering - Enhanced: Trigger status

· Triggered measurement

· Thermocouple measurement

· Artificial sine - signal generation using imc Online FAMOS

5.1  Simple measurement - First steps

Assignment:

Set up an experiment. A measurement on an analog channel is to be started and the measurement results are to
be displayed on a Panel page. The signal applied in this example is a ±2 V sawtooth voltage with a 1 Hz base
frequency. If you use a different signal, modify the channel settings accordingly.

Learning goals:
· Creating an experiment

· Simple device operation

Elements used:
· Search for devices, device selection , connection with a device, channel settings

Prerequisite:
· imc measurement device with an analog channel

Procedure:

Connect a signal generator with "Channel_001" on your device. Refer to the device manual to see how to
connect a signal with your device (plugs, etc.).

Start imc STUDIO as described in the section "Start ".
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5.1.1  Setup - Settings
To begin, the measurement device is selected and configured.

· Open the device configuration page: "Setup".

· Go to the tab: "Devices" .

Here you will find any devices which are known to the system due to having been used before. Following the
first installation of imc STUDIO, the list is empty.

Select your device:

· If the device desired does not appear in the list, perform a device search ( ). Subsequently, the list will

display all devices found.

Ribbon View

Home > Search for devices ( ) all

Setup-Control > Search for devices ( ) Complete

· Click on the Checkbox-symbol ( ) in order to select the device.

Selecting a device

The device is now known and selected, and is available each time imc STUDIO is started.

Configuring a channel

Now the channel used is configured:

· Go to the tab: "Analog channels" .

Under Channel type: "Analog inputs", select "Channel_001". By default, this is set to "active". In order to make
settings, click in the respective box and change the entry.
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Set "Channel_001" in accordance with the input signal from your generator. In this example:

Parameter Value Dialog (View: Standard) Dialog (View: Complete)

Mode Voltage Measurement mode Measurement mode

Coupling DC Measurement mode Measurement mode

Input range ±2.5 V Measurement mode Range & Scaling

Type AAF Sampling & Filtering Filtering

Sampling rate 100 Hz Sampling & Filtering Sampling & Preprocessing

Duration 10 s Sampling & Filtering Sampling & Preprocessing

Conf iguring measurement channel by the dialogs

· To apply the changes, click on the button "Process conf iguration" ( ).

Ribbon View

Home > Process ( ) all

Setup-Control > Process ( ) Complete

By this means, the device settings are available to other components.

5.1.2  Panel - Settings / Start measurement
To display measured values, create a Panel page.

· Open the page: "Panel".

Reference Panel description

How the Panel is structured is presented in the manual in the chapter: "Panel - Data visualization and
controls".

Editing can only be performed in Design mode (e.g. add new Widgets, change properties etc.).
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· Activate the Design mode ( )

Ribbon View

Panel-Navigation > Design Mode ( ) Complete

Panel-Design > Design Mode ( ) Complete

Home > Design Mode ( ) Standard

Note Notes on Data Browser

The "Panel" has various tool windows. In "Data Browser" you can see the device's channels as shown in the
image below. Following changes to the "Setup", this list must be updated using the command "Process
conf iguration".

· Open the tool window "Data Browser" and select the analog input: "Channel_001".

· Use Drag&Drop to drag this channel to the page, either by grabbing its icon or its name (but do not grab
the @-symbol; this will be explained in the next section).

A menu appears offering Widgets appropriate for the analog channel's data type.

· Select one of these Widgets. In the example, a "standard curve window" is selected.

Reference Curve window documentation

This Widget is the curve window, which is also used in other imc software packages. More information is
provided in the manual in the section. Chapter:
"Panel" > "Curve window".

Dragging an analog channel to the Panel page

There are a variety of Widgets available. The example (in the picture above) may differ from your configuration.

Following selection, the selected Widget appears on the Panel page and is linked with the analog input:
"Channel_001".

As long as the Widget is selected, a cross appears in the center ( ). This can be used to move the Widget or

open a context menu there (by right-clicking).

· Deactivate the Design mode ( ).
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Save experiment

Save the experiment:

· Click on the button: "Save as" ( ).

· Save the experiment under the name "First Steps".

Ribbon View

Home > Save as ( ) all

Project > Save as ( ) Complete

Starting measurement
· To transfer the current settings to the device, click on the button "Prepare" ( ).

Ribbon View

Home > Prepare ( ) Complete

Setup-Control > Prepare ( ) Complete

Note Preparation of the device

The menu item "Prepare" is not present in the "Standard" view. That is because it does not need to be
performed manually. Instead, preparation of the devices is performed automatically unless it had already
been initiated manually.

· Start the measurement ( ).

Ribbon View

Home > Start ( ) all

Setup-Control > Start ( ) Complete

Curve window
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After ten seconds, the measurement ends automatically. You can also start measurement multiple times and
stop it prematurely using the associated button ( ).

Ribbon View

Home > Stop ( ) all

Setup-Control > Stop ( ) Complete

Using the curve window, you can analyze the data in a wide variety of ways.

Saved measurement data

At the end of measurement, the measurements are each saved in a separate subfolder in the Experiment folder.
The folder is named according to the respective measurement's start-time stamp.

The saved measurement appears in the Data Browser:

Saved measurement data (example)

· Perform at least two more measurements (so that there are at least three measurements).

Note Permanent data storage

By default, data saving is activated for all channels. Activation of data storage ensures that no measured
data are lost. Subsequently, it is always possible to delete the measured data once they are no longer
required.

It is possible to deactivate saving of the data. The next examples illustrate additional ways to save measured
data.

Reference

More information on activating the data storage is provided in the manual in the section:
"Setup pages - Conf iguring device" > "Configuring channels and variables" > "Data transfer".
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5.1.3  Panel - Messungen nacheinander betrachten
The saved measurements also can be displayed on the Panel page. You can link a variable either by its fixed
name or its symbolic name with a Widget.

Fixed name <VariableName>@<Measurement Name>

e.g. Channel_001
In this way, the Widget always indicates the current measurement.

or Channel_001@2022-01-06 12-00-20
in this way, the Widget is always linked with this concrete measurement

Symbolic name <VariableName>@Measurement#<Measurement number>

e.g. Channel_001@Measurement#1
Contains the name of the variable followed by a measurement number. The measurement
number can be assigned variably with the Data Browser.

This enables you to compare measurements. After measurement, you can select the saved
measurement (it is then assigned the the number "1"). Subsequently, all Widgets show the
variables belonging to the saved measurement.

If you have opened a measurement in the Data Browser, the "@" Symbol ( ) appears in the Numbering
column. To link a variable with a Widget via a measurement number (symbolic name), use Drag&Drop to move
the variable from the "@"-symbol to the page.

Variable linkage with symbolic name.
Example: "Channel_001@Measurement#1"

To link a variable with a Widget by its fixed name, move the variable to the page from the name column using
Drag&Drop.

Variable linkage with f ixed name.
Example: "Channel_001@2022-01-06 12-00-20"
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Reference Linkage of variables

More information on linkage of variables is provided in the manual in the section:
"Panel" > "Variable linkage". 

· Create one new curve window for each of the two ways described

One of the curve windows is linked with a defined measurement. The other displays the channel belonging to
the measurement selected.

· Select a different measurement: the measurement is automatically loaded and displayed.

Note Always display all data

If you intend for the complete measurement to always be displayed whenever changing measurements, the
following settings for the curve window are optimal:

· Scroll mode: "No"

· Timeline(x-axis): "automatic"

This causes a similar situation as the "Stretch" mode. The difference is that then the complete data set is
always shown (the left side also adjusts accordingly.) This mode is suitable for reports when measured data
are to be loaded in succession and displayed completely in a curve window.

Attention: In cases of very large data sets, this mode can cause significant performance problems if all data
points are displayed.

Save the experiment

You have thus concluded your first experiment. Next, save the experiment again:

· Click on the button: "Save" ( ).

5.2  Circular buffer memory for the display

Assignment:

Compare the data which is available during the measurement with the saved measured data.

Learning goals:
· Data flow: from the device to the PC, for display and storage purposes

· the effects of circular buffer memory on the measured data

Prerequisite:
· imc measurement device with an analog channel

Procedure:

Begin by start imc STUDIO.
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5.2.1  Background-info: The data stream

Once the measurement starts, the measurement device generates a data stream. The goal in every
measurement is to process this data stream and to observe and or save it.

Simplif ied schematic of  the data stream illustrated by the imc CRONOS device

The data stream is first written to FIFO RAM buffer memory in the device.

Once the data have been processed in the device, they can be transferred to the control PC ①. The data can be
displayed on Panel pages ③. Additionally, the measured data which have been transferred can be saved on the
PC ②.

· By default, the data for the display are saved on the PC in a circular buffer ①. By using the circular buffer
memory, it is possible to temporarily store the data in the higher speed ("rapid access") working memory
(RAM). This improves performance and enables continuous data transfer no matter how long the
measurement runs.

· For data storage purposes, circular buffer memory is not used.

Whether or not data are transferred to the PC and whether they can be saved can be set for each channel
separately. By default, data saving on the PC is activated.
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5.2.2  Setup - Settings

First, the measurement device is configured.

· Open the device configuration page: "Setup".

· Go to the tab: "Devices" .

Select your device: 

· If the device desired does not appear in the list, perform a device search ( ). Subsequently, the list will

display all devices found.

Ribbon View

Home > Search for devices ( ) all

Setup-Control > Search for devices ( ) Complete

· Click on the Checkbox-symbol ( ) in order to select the device.

Selecting a device

The device is now known and selected, and is available each time imc STUDIO is started.

Configuring the channels

· Go to the tab: "Analog channels" .

Under Channel type: "Analog inputs", select "Channel_001". By default, this is set to "active". Make settings for
"Channel_001" in accordance with its input signal. Also ensure that the following settings are applied:

Parameter Value Dialog (View: Standard) Dialog (View: Complete)

Duration 30 s Sampling & Filtering Sampling & Preprocessing

Circular buffer time 10 s Data transfer Data transfer

Save data (PC) Checkbox activated (true) Data transfer (below "Transfer
to PC")

Data transfer (below
"Transfer to PC")

· To apply the changes, click on the button "Process conf iguration" ( ).

By this means, the device settings are available to other components.

5.2.3  Panel - Settings / Start measurement
Now you can create the Panel page.

· Open the page: "Panel".

· Activate the Design mode ( )

Create a curve window showing the channel: "Channel_001" and start the measurement.
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Observe what happens after the first 10 s → The first data are deleted. There are always only a maximum of 10 s
worth of measured data.

After 30 s, measurement stops automatically and a completed measurement appears in the Data Browser. Also
observe "Channel_001", which has been saved. It contains all 30 s worth of data.

The channel under "Current measurement" contains only the last 10 s of  the entire measurement.
The saved channel contains all 30 s.

Conclusions

For the purpose of displaying the channel data from indefinitely long measurement runs, use the circular buffer
memory. This circular buffer displays the data for a specified duration. Note that many functions directly access
the circular buffer; for instance, the imc FAMOS-command (during a measurement), or subsequent data storage
in response to the button "Save current Data ".

Give careful prior thought to how much circular buffer memory your application will need. If you select a volume
which is too large, the performance can be adversely affected, especially when trying to display too much data in
a curve window.

If the demands on the PC ever become too great for the data to be processed punctually, data overflow can
occur.

Reference Data overflow

Additional useful notes on the topic of data overflow are provided in the manual in the following sections:
"Setup pages - Conf iguring device" > "Information and tips"

· "Avoidance of  data overf low"

· "Behavior upon data overf low"
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5.3  Subsequent saving of measured data

Assignment:

Perform a measurement without simultaneous data saving, and save the measured data subsequently on the
hard drive.

Learning goals:
· Use of subsequent data saving

Elements used:
· Menu action: "Save current Data"

Prerequisite:
· imc measurement device with an analog channel

Procedure:

Load the experiment "First Steps" from the tutorial "Simple measurement - First Steps " or stop the current
measurement ( ) if it is still running.

To load the experiment:

· click on the button: "Open" ( )

· select the experiment "First Steps" and confirm by clicking in the dialog on "Open"

Save the experiment under a new name: "First Steps without data saving"

· To do this, click on the button: "Save as" ( ).

52
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5.3.1  Setup - Settings

Deactivate storage of the measured data for the active measurement channel.

· Open the device configuration page: "Setup".

· Go to the tab: "Analog channels" .

Under Channel type: "Analog inputs", select "Channel_001".

Deactivate storage of the measured data on the PC for the analog input: "Channel_001".

Parameter Value Dialog (View: Standard) Dialog (View: Complete)

Save data (PC) Checkbox deactivated
(false)

Data transfer Data transfer

Note

The option "Save data" appears on the "Data transfer" page in two places. Once where it activates storage
of the measured data on the device, and once for storage on the PC.

Deactivating the storage of  measured data using the dialogs

Note

By default, data saving is activated for all channels.
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5.3.2  Panel - Starting measurement

Open the Panel page and perform a measurement.

· To transfer the current settings to the device, click on the button "Prepare" ( ).

· Start the measurement ( ).

Curve window

After ten seconds, the measurement ends automatically.

5.3.3  Subsequent saving of measured data
In this example, the data were not saved permanently. No data are on the hard drive, but these can be saved
retroactively.

· Click on the button: "Save current Data".

Ribbon View

Project > Save current Data ( ) Complete

Home > Save current Data ( ) Standard

· If the action has not been configured otherwise, a dialog appears which prompts you to enter a folder
name. The suggested default value is the current time stamp. Close the dialog by selecting "OK".

Dialog: Save current Data

Subsequently, all channels (including analog channels, virtual channels, ... ) belonging to the experiment are
saved to the hard drive. Within the experiment folder, a folder having the specified name is created, in which the
data are then stored.
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In the Data Browser, a folder corresponding to the folder name appears, which contains the saved measurement
data. You can load and view it using the Panel.

Saved measurement data (example)

Note

· The measurement folder created represents a complete measurement. It is treated in the same way as
any folder created by means of normal measurement data saving.

· No single values can be saved in this way. These include, for instance, Display variables.

· The measured data saved by means of "Save current Data" are always stored in the experiment folder. If
you wish to save them to a freely selectable folder, use the button: "Export current Data". Be aware that
measured data saved in this way are not recorded in the Data Browser and can thus not appear there.

Warning Constraints

Be aware that with this function, only such variables are saved, which are found in the Data Browser under
"Current measurement". For these variables, a  circular buffer memory is usually activated, so that not all
results since the measurement start are available.
For device-variables, therefore, the Data Transfer Settings are applicable. The storage type: "Display,
calculation of  measured data" is used.

See the tutorial: "Circular buf fer memory for the display "

Reference

More information on the function: "Save current Data" is presented in the manual in the section:
"Setup pages - Conf iguring device" > "Storage options and directory structure" > ".." > "Targeted Data
Saving, or Saving Subsequent to Measurement".
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5.4  Simple triggering

Assignment:

Display a measurement on an analog channel. Use a switch on the Panel page in order to interactively start and
stop measurement on this channel.

Learning goals:
· Creating an experiment

· Simple device operation

· Use of a trigger

Elements used:
· Trigger

Prerequisite:
· imc measurement device with an analog channel

Procedure:

Begin by starting imc STUDIO.

5.4.1  Setup - Settings

First, the measurement device is configured and an appropriate name is assigned to the variables.

· Open the device configuration page: "Setup".

· Go to the tab: "Devices" .

Select your device

Configuring the channels

· Go to the tab: "Analog channels" .

Under Channel type: "Analog inputs", select "Channel_001". By default, this is set to "active".
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· In order to set a measurement of unlimited duration, in the column "Sampling & Filtering", on the row
"Duration" set the value "Undefined" by means of the pop-down symbol ( ).

Unlimited measurement duration

· Go to the tab: "Variables" .

· Under Channel type: "Virtual bits", click on "Virt_Bit01" and rename it to "Switch_position". If desired, you
can enter a comment ("Measurement to display/stop").

Channel type "Virtual bits"
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Defining triggers

· Go to the tab: "Triggers" .

· To define the virtual bit "Switch_position" as a source, click in the column "Sources and Events" on the
plus-sign symbol ( ).

· Select "Switch_position".

Trigger source

In order to be able to release the trigger multiple times, in the column "Properties" the "Repetitions" is set to
"Unlimited".

· As the target, specify "Channel_001"

The measurement is to start when Switch_position = 1  and stop when Switch_position = 0. To
accomplish this, set the "Begin action" and "End action" as shown in the picture below.

Parameter Value

Trigger begin action start

Trigger end action stop

Settings for the trigger

· To transfer the current settings to the device, click on the button "Prepare" ( ).
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5.4.2  Panel - Settings / Start measurement

Now you can create the Panel page.

· Open the page: "Panel".

· Activate the Design mode ( )

Switch
· From the Data Browser, you can now drag the "Switch_position" (found under Channel type: "Virtual bits")

to the Panel page.

· After releasing the mouse button (Drag&Drop technique), a context menu appears. From this context
menu, select "Switch".

Dragging a virtual bit to the Panel page

A wide variety of Widgets are now available. Please note that the image below is only an example and may not
correspond to the Widgets available to you.

Now the switch on the Panel-page is linked with the virtual bit in the device named "Switch_position". Using the
switch, you can interactively switch the virtual bit on and off.

By means of the Widget-property: "Text", you can label the switch; e.g. "Trigger start". To do this, open the
context menu over the crosshairs ( ) within the selected Widget and select the entry: "Properties".
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Note Additional Widgets

Depending on the product configuration, additional Widgets are available. Instead
of a simple switch, you could select a "Rocker switch", for example, under the
heading "Automotive".

Curve window

After positioning the switch on the Panel page, next create the curve window:

· Drag the analog channel "Channel_001" from the Data Browser to the Panel page.

· Upon releasing the mouse button, you see a context menu where you will select the entry "Standard". This
creates a standard curve window.

Dragging an analog channel to the Panel page



© 2025 imc Test & Measurement GmbH imc STUDIO 2025 - Getting Started, Doc. Rev.: 8.1 - 2025-03-11
Page   72

Simple triggering Chapter   5

Example: Completed Panel page with two Widgets

As long as the Widget is selected, a cross appears in the center ( ). This can be used to move the Widget or

open a context menu there (by right-clicking).

· Deactivate the Design mode ( ).

Starting measurement, clicking buttons, stopping
· Start the measurement ( ).

"Channel_001" is triggered by the virtual bit "Switch_position". This means that when you click on the switch,
data capture on "Channel_001" starts/stops.

· Click on the switch multiple times.

Save experiment

With this, you have concluded the experiment. Save the experiment:

· Stop the measurement ( ).

· Click on the button: "Save as" ( ).

· Save the experiment under the name "Simple Triggering".

Reference

For an additional display of text on the Panel page to indicate the status of the measurement, please read
about the enhancement: "Einfache Triggerung - Erweiterung ".73
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5.5  Simple triggering - Enhanced: Trigger status

Assignment:

A text box on the Panel page displays the trigger's state. The states are ("running", "stopped").

Learning goals:
· Using trigger-variables

Elements used:
· Listboxes, Zones, Trigger variables

Prerequisite:
· This is an enhancement of the experiment: "Simple Triggering ", which must already exist.

· The same conditions apply as for the experiment: "Simple Triggering"

Procedure:

Begin by starting imc STUDIO.

· Load the experiment "Simple Triggering" or stop the current measurement ( ) if it is still running.

· Save the experiment under a new name: "Simple Triggering - Enhanced"

· To do this, click on the button: "Save as" ( ).

67
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5.5.1  Panel - Settings / Start measurement

Note Widgets

The status of the trigger can be displayed using a variety of Widgets. In this example, a simple list is used
which is able to display texts. Other Widgets from the advanced groups offer more display options, but
these are not available in all Editions.

Top Widget from the group: "Standard".

Other Widgets, belonging to the groups
"Automotive", "Industrial" and "Designer"

· Open the page: "Panel".

· Activate the Design mode ( )

· Drag the Widget: "Listbox" to the Panel page:

· Tool Window: "Widgets" - Group: "Standard" > "Listbox".

The "Listbox" is configured in the Widget-properties. To do this, open the context menu over the crosshairs ( )

within the selected Widget and select the item: "Properties".

· Under the property: "Variable", select the trigger's status-variable: "Trigger" > "Trigger_01" > "State".

Note Trigger status indication

This provides an indirect linkage between the switch and the selection box. When the switch is actuated,
the trigger releases. Once the trigger releases, the selection box indicates the operative status.

Conversely, the Widget also provides an indication when the trigger release failed. As a simple example, this
can happen if the measurement had not previously been started.
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Setting up and adapting states (zones)

The states displayed are to be adapted. For this purpose, some of the Widgets have the property: "Zones".

· Click on the symbol  as shown in the following picture:

States (zones) def ined for the selection box

In the dialog window, it is now possible to define the zones. The measurement has two possible states:
"stopped" and "running".

· Only two zones are required; begin by deleting all but two zones

· Enter the zones as shown in the following picture:

Zones

· Deactivate the Design mode ( ).

· Start the measurement ( ).

· then click on the switch on the Panel page
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The listbox changes (running, stopped) in response to the switch position:

Optional settings:

Button: "Hide"

Foreground color: "White"

Saving

With that, you have completed this example and can save it. Since the experiment has already been saved under
a new name, it is sufficient to save the changes.

· Stop the measurement ( ).

· Click on the button: "Save" ( ).

Note Possible enhancements and additional exercises

· Indicate the count of previous trigger-releases. For this purpose, use the trigger-variable: "Trigger" >
"Trigger_01" > "EventNumber".

· Indicate whether the measurement is running. For this purpose, use the device system variable: "System"
> "Experiment" > "Measurement status".

5.6  Triggered measurement

Assignment:

The analog channel is to measure for 5 ms if the input signal exceeds the threshold 3 V. Apply a signal at the
measurement device's analog input, with adjustable amplitude, e.g. by means of a function generator.

Learning goals:
· Use of a trigger

· Setting a channel according to the expected input signal

Elements used:
· Trigger event

· Monitor channel (this channel type cannot be used with imc EOS devices).

Prerequisite:
· imc measurement device with an analog channel

· A function generator or other signal source

Procedure:

Setting a function generator: Set up a sine function with a frequency of 1 kHz and initial amplitude of 2 V, for
example.

Next, start imc STUDIO.
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5.6.1  Setup - Settings

To begin, the measurement device is configured.

· Open the device configuration page: "Setup".

· Go to the tab: "Devices" .

Select your device

Configuring the channels

· Go to the tab: "Analog channels" .

Under Channel type: "Analog inputs", select "Channel_001". Make the following settings for the channel's
parameter configuration:

Parameter Value  

Status Active  

Mode Voltage  

Coupling DC  

Input range ± 5 V  

Sampling rate 100 kHz  

Duration 5 ms  

Under Channel type: "Monitor: Analog inputs", select "Mon_Chan_001". Make the following settings for the
channel's parameter configuration:

For devices belonging to the firmware group A (imc DEVICES) - e.g. CRONOS Familie, C-SERIE, SPARTAN, BUSDAQ

Parameter Value  

Status Active  

Sampling rate 10 kHz  

Duration Undefined  

Note

The monitor channel's sampling rate can only be set to a value less than the analog input's sampling rate.

For devices belonging to the firmware group B (imc DEVICEcore) - e.g. ARGUSf it, EOS

Parameter Value  

Status Active  

Function (Preprocessing) Arithmetic mean  

Points 10  

Duration Undefined  
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Defining triggers

· Go to the tab: "Triggers" .

In the column "Sources and Events" set "Channel_001" as the source, with the following event:

Parameter Value  

Event type Threshold  

Event Signal > Threshold  

Event threshold 3 V  

In the column "Properties" set the following:

Parameter Value  

Combination Or  

Repetitions 1  

In the column "Targets, begin actions, end actions, pretrigger" set "Channel_001" as well as a target, since it is to
be used as a triggered event and measurement channel.

Parameter Value  

Begin action start  

End action -  

Pretrigger 0 s  

Settings for the trigger

Prepare
· To transfer the current settings to the device, click on the button "Prepare" ( ).

5.6.2  Panel - Settings / Start measurement

Now you can create the Panel page.

· Open the page: "Panel".

· Activate the Design mode ( )

Create a curve window containing "Channel_001":

· From the Data Browser drag the variable: "Analog inputs" > "Channel_001" to the Panel page.

· In the Widget selection list, select: "Curve window" > "Standard".
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Curve window properties

More Channels

In a curve window it is possible to display more than one channel.

· Right-click the mouse over the curve window (not over the cross ( ) in the center).

· In the context menu which then appears, select "Configuration" and subsequently the command "More
Channels"

A dialog appears, in which you can select additional channels which are then displayed in the same curve
window.

All data sets available for selection are displayed in the list at right: "Available Channels". The data sets already
displayed in the curve window are indicated in the list at left: "Axes List".

· Drag "Mon_Chan_001" from "Available Channels" to the box "Axes List".

Channels for the curve window
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· In order to display the two channels on different Y-axes, click on the coordinate-system symbol ( ).

· Next, select the channel "Mon_Chan_001". This now contains a single coordinate system.

To apply the settings, click on the button "OK".

Saving

With that, you have completed this example and can save it:

· Save ( ) the experiment under the name "Triggered measurement".

Starting measurement, observing results
· Deactivate the Design mode ( ).

· At the input: "Channel_001", for example, apply a sinusoidal signal with an amplitude of < 3 V an

· Start the measurement ( ).

· after a while, change the amplitude to a value > 3 V.

As soon as the amplitude exceeds 3 V, "Channel_001" is recorded for 5 ms duration. "Mon_Chan_001" records
the data already upon the measurement's start.

· Stop the measurement ( ).

Evaluating measured data

Observe the complete measurement. To do this, perform a rezoom in the curve window (context menu item:
"Edit" > "Rezoom").

Notice that both channels start at the time point "0 s".

Adjusting the axes

The two channels have differing Trigger-times, but by default they are both displayed in the curve window
stacked one above the other at x = 0. Thus in this example, each channel begins at x = 0, even if the triggered
channel: "Channel_001" is started later.

In order that the two channels' time coordinates to be synchronized, the scale of the x-axis must be adjusted.

· Right-click he mouse over the curve window (not over the cross ( ) in the center).

· In the context menu which then appears, select "Configuration" and subsequently the command "Axes"

A dialog appears in which you can adapt the curve window's axes.

· In order to see the x-axis' settings, select the axis "x1" from the list at left: "Axes List".
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Then make the following setting:

Parameter Value  

Scale Date/time: absolute  

Setting the axis for the curve window

To apply the settings, click on the button "OK".

Now the two channels are displayed in parallel with correct reference to time. To investigate the data, you
need to zoom in on the correct location in the curve window.

· Use the context menu item "Edit" > "Zoom"

Measurement of  the channel's signal only starts once the trigger event occurs
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Save the experiment

Save the experiment again:

· Click on the button: "Save" ( ).

5.7  Thermocouple measurement

Assignment:

A temperature is to be measured by thermocouple.

Learning goals:
· Advanced channel settings

Element used:
· Sensor & scaling

· Pre-processing of data

Prerequisite:
· imc measurement device with an amplifier for temperature measurement

· Type K Thermocouple

· An appropriate connector with which to connect the thermocouple with the imc measurement device

Procedure:

Connect the thermocouple to "Channel_001" of the imc measurement device.

Next, start imc STUDIO.

5.7.1  Setup - Settings

To begin, the measurement device is configured.

· Open the device configuration page: "Setup".

· Go to the tab: "Devices" .

Select your device
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Configuring the channels

· Go to the tab: "Analog channels" .

Under Channel type: "Analog inputs", select "Channel_001". Make the following settings for the channel's
parameter configuration:

Parameter Value Dialog (View: Standard) Dialog (View: Complete)

Name Thermocouple Channel definition Channel definition

Status Aktive Channel definition Channel definition

Mode Voltage Measurement mode Measurement mode

Coupling DC Measurement mode Measurement mode

Correction Type K Measurement mode Measurement mode

Input range -270..500 °C Measurement mode
Range & Scaling

Measurement mode
Range & Scaling

Filter type AAF Sampling & Filtering Filtering

Sampling rate 1 kHz Sampling & Filtering Sampling & Preprocessing

Duration Undefined Sampling & Filtering Sampling & Preprocessing

Function Arith. Mean - Sampling & Preprocessing

Points 50 - Sampling & Preprocessing

By means of the correction , the input range and the unit are automatically adapted.

The arithmetic mean of 50 sampled points produces a resulting sampling rate of 20 Hz, since groups of
50 points each are summarized by one point.

Prepare
· To transfer the current settings to the device, click on the button "Prepare" ( ).

5.7.2  Panel - Settings / Start measurement

Now you can create the Panel page.

· Open the page: "Panel".

· Activate the Design mode ( )

Create a curve window containing Thermocouple:

· From the tool window: Data Browser, drag the variable: Analog inputs > Thermocouple to the Panel page.

· In the Widget selection list: Standard (curve window).

Curve window properties

Adjusting axes

Adapt the axis settings:

· Right-click the mouse over the curve window (not over the cross ( ) in the center).

· In the context menu then appears, select Configuration and subsequently the command Axes...

A dialog appears in which you can adapt the curve window's axes.

· In order to see the y-axis settings, select the axis y1 from the list at left (Axes List).
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Now make these settings:

Parameter Value  

Scale Linear  

Range selection Fixed range: min, max  

Minimum [°C] 0  

Maximum [°C] 40  

Tick selection Ticks at fixed distances  

Tick distance [°C] 5  

Settings for the y-axes

In order to apply the settings, click on the button "OK".

· Display a grid by means of the curve window's context menu item Configuration > Grid.

· Insert a text box with the text: Measurement Thermocouple and adjust the font size and the Widget-size.

· Deactivate the Design mode ( ).
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Starting measurement, observing results
· Start the measurement ( ).

The following picture illustrates one possible display of the course of the temperature signal.

Curve window with plot of  temperature

Saving

With that, you have completed this example and can save it:

· Stop the measurement ( ).

· Save ( ) the experiment under the name "Thermocouple measurement".
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5.8  Artificial sine - signal generation using
imc Online FAMOS

Assignment:

Generate an artificial sinewave imc Online FAMOS and display it on the Panel page. The frequency and
amplitude are to be adjustable by Widgets.

Learning goals:
· Use of imc Online FAMOS

· Exercising control via the Panel

Element used:
· Connection with a device

· Channel settings

· imc Online FAMOS

Prerequisite:
· imc measurement device with an analog channel

Procedure:

Begin by start imc STUDIO.

5.8.1  Setup - Settings

First, the measurement device is configured and the variables used are assigned an appropriate name.

· Open the device configuration page: "Setup".

· Go to the tab: "Devices" .

Select your device
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Configuring the channels

· Go to the tab: "Analog channels" .

Under Channel type: "Analog inputs", select "Channel_001". Make the following settings for the channel's
parameter configuration:

Parameter Value  

Name Clock  

Status Active  

Mode Voltage  

Coupling DC  

Input range ± 5 V  

Sampling rate 1 kHz  

Duration Undefined  

· Go to the tab: "Variables" .

· Under the Channel type: "Display variables", rename the following variables:

· DisplayVar_01 > Amplitude

· DisplayVar_02 > Frequency

imc Online FAMOS

· Open imc Online FAMOS ( )

Ribbon View

Start > Online FAMOS ( ) all

Setup-Configuration > Online FAMOS ( ) Complete

· Enter the following source code in the imc Online FAMOS Editor:
t = integral(Clock * 0 + 1)
Oscillation = Amplitude * Sin(6.283185 * Frequency * t)

Note Explanation

Pulse sequence

The expression Clock * 0 + 1 generates the sequence of unit pulses u[n]
after the measurement starts.

Since the channel's sampling frequency is 1 kHz, the pulse sequence consists of
1000 values per second. By integrating the unity pulses, one obtains a straight
line with slope 1. The time "t" thus increases linearly.

The general shape of the sine: x(t)=A*sin(u*t) with u=2*Pi*f=6.283185*f.

Here it is to be noted that the signal is also discrete and has 1000 values per second. In order to change the
resolution, you simply need to change the channel's sampling frequency.

The virtual channels you defined, "t" and "Oscillation" are generated automatically by this assignment.

· Select the Syntax Check ( ) and exit imc Online FAMOS.



© 2025 imc Test & Measurement GmbH imc STUDIO 2025 - Getting Started, Doc. Rev.: 8.1 - 2025-03-11
Page   88

Artificial sine - signal generation using imc Online FAMOS Chapter   5

Prepare
· To transfer the current settings to the device, click on the button "Prepare" ( ).

5.8.2  Panel - Settings / Start measurement

Now you can create the Panel page.

· Open the page: "Panel".

· Activate the Design mode ( )

In the tool window: Data Browser you should find the virtual channel "Oscillation" created in imc Online FAMOS.

· From the tool window: Data Browser drag the variable: Virtual channels > Oscillation to the Panel page.

· In the Widget-selection list, select: Standard (curve window).

In order to change the values of variables Frequency and Amplitude, these are displayed on the  Panel page with
suitable Widgets.

· Drag the variable: Display variables > Amplitude to the Panel page.

· In the Widget  selection list, select: group Standard > Editor box (Single line).

· Drag the Widget: "Label" to the Panel page:

· Tool Window: Widgets - Group: Standard > Report > Label.

To adapt the Text, open the label's Properties.

· In the box Text, enter "Amplitude".

Display the variable Frequency in the same way.
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Start measurement, observe results
· Deactivate the Design mode ( ).

· Start the measurement ( ).

· change the Amplitude and the Frequency and observe how the curve window changes:

Sinus

Saving

With that, you have completed this example and can save it:

· Stop the measurement ( ).

· Save ( ) the experiment under the name "Artif icial Sine".
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6  Experiments, projects and the database
This chapter describes the interdependencies among the "database", "projects", "experiment templates" and
"experiments".

Experiment

The experiment includes a record of all settings needed for generating the measurement data as well as viewing
and evaluating them. The actual measured data are saved with the "experiment" to which they belong.

You can create a variety of experiments to accomplish a corresponding variety of measurement tasks.
imc STUDIO always works with exactly one experiment and all changes are saved to it.

Among others, the following settings are saved:

· the experiment file (filename extension: "*.imcStudio"),

· measurement files and metadata,

· various backup files and administration files

Among other things, the experiment file contains all the settings configured in the main windows and in the
Setup-Assistants.

Each experiment has a unique name which is set when it is saved .

Measurement data

By default, the measured data are saved in the Experiment folder. They belong to the experiment. You specify
the data structure in the Device-settings under "Storage" (Setup page: "Devices" > "Storage").

Project

A project is primarily a collection of various experiments. The factory settings of imc STUDIO are configured in
such a way that only one project is present and that you are aware of it to the minimum extent possible.

All of your experiments are saved in this project ("StandardProject").

Some options and configurations are not saved along with the experiment. For instance, they might be saved
along with the project and apply to all experiments belonging to the project. In some cases, you can define what
has to be saved where. E.g. when generating variables, you can change the validity scope and, for instance, save
it not just for that experiment but for all experiments in the project.

Whatever is saved at the Project level (and thus not with the specific experiment) is correspondingly denoted at
the locations affected. A project can include:

· one or more experiments

· one or more experiment templates

· project settings (e.g. views, user administration and project-events)

After the first start of imc STUDIO, a standard project is set up in which your experiments are saved.

95
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Project view - working with multiple projects

When you activate "Project view", there is a project-based tree diagram in the Open- and Save-dialogs . Here,
you can create additional projects and load experiments from other projects.

Note  Creating a project resets variables

When you create a new project, the status of the experiment currently open is saved temporarily and
reloaded later after the new project has been set up. In consequence, the values of the variables are reset
to the condition they would have if the experiment were re-loaded.

In the process, the event "Experiment_Loaded" is not triggered. If you need this to happen for your
experiment, please re-load it manually. If you save your experiment with the new project ("Save As"),
something similar happens. Here, too, the variables are reset, but additionally the event
"Experiment_Loaded" is triggered.

You can activate the "Project view" in the options (under "Project Management" > "General options"):

Ribbon View

Extra > Options ( ) All

Option Description

Project view activated

To create more projects, you must activate the Project view. This option is deactivated by
default. (Information on Projects ).

There is an extended view available of some dialogs . Multiple projects can be created
and used.

Only activate the Project view if you wish to use and manage multiple
experiments in separate projects.

If this function is deactivated, some dialogs are displayed in simplified
form (e.g. "Save experiment" and "Open experiment" are missing Project
selection, for instance).

Database

The database is the data repository for imc STUDIO. Here, the projects and their associated experiments are
saved. The database does not have its own settings and configurations.

The folder path for the database can be freely selected (in the Options under: "Project Management" > "HDD
Settings").

Ribbon View

Extra > Options ( ) All

Option Description

Database folder

Here you set where the "Database" is to be saved. (Information on "Data management")

The database is not user-dependent. Note that every user who is set up in
the system has writing and reading rights for this path.

94
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Database conversion

If the database structure has been changed, you are subsequently notified. One way
this can happen is as a result of updating to a new version.

A conversion-dialog appears. You can convert the database or have it copied
beforehand. After the conversion, the entire database can no longer be used with
the older version.

Databases are not
downward compatible.

In the upper region, the reason why the database does not fit with the current version is noted. E.g., the
database may be too new or too old. In the list below, all databases found in the folder selected are listed. The
"Status"-bar contains information on the database.

The following approaches are available:

Approach Description

Select an existing database Select the appropriate database and click on the button "Apply".

If it is necessary to convert the database, an additional dialog appears. Here, the user is
prompted to decide whether to use the database under a new name. If you choose:

· no: the existing database is converted. It can no longer be used with the older version.

· yes (recommended): the database is copied. Enter a name for the new database. Now
you have two databases. You will have a backup copy and can continue to use the old
database with the old version.

Create a new database Click on "Create new". Enter an appropriate name for the database. It will be created in the
folder selected (parallel to any already existing databases).

Change the database's
folder

Click on the button "..." next to where the folder is indicated. Select an appropriate folder.

Here, select a folder where the database folder is to be created later. Not
the database itself. E.g. the default folder: "C:\Users\Public\Documents".
The database will be created in this folder, e.g. "DB".

Experiment Template
See: "Experiment Templates "

Creating one's own files on an experiment - in the folder "Meta"

You can create your own files on the experiment, such as metadata, imc FAMOS-sequences, info-files. To do
this, use the folder: "Meta" in the experiment path. If you save or export the experiment under a different
name, all files from the folder "Meta" come along with it.

The folder "Meta" is now ignored in all components.

· The content is not recognized as a measurement although containing measured data. This means that
there is no entry in the Data Browser.

· Interval saving does not delete the folder. When the number of intervals is limited, the folders of measured
data are deleted in succession once the specified count has been reached. The folder "Meta" is ignored,
even when the folder contains measured data.
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6.1  Dialogs: Project and Experiment
The Project Management dialogs are described below:

· with "Project view" and

· with "Experiment templates".

By default, these options are deactivated, in consequence of which not all functions are available. Options-
dependent functions are mentioned explicitly below.

The dialogs following the functions "Manage Project", "New Experiment", "Save As" and "Open" are structured
similarly. The dialog is described below on the basis of "Project Management" as an example. Not all dialogs
feature the complete scope of functionality.

Example: Manage project

The dialog is subdivided into four regions (from top to bottom):

1. Menu bar

2. List of all projects

3. List of all experiments and experiment templates in the selected project

4. Linked metadata information belonging to the selected experiment

By default, the regions 1 and 3 are displayed; the others can be activated if desired.

Region 1: Menu bar

Function Description

New

Create new project: Creates a new project in the selected database (a database must be
selected).

Create new experiment template: Creates a new experiment template  (a project must
be selected).
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Function Description

Import

Imports elements (projects, experiments and or experiment templates) from a file in the
selected entry.

The file can contain multiple elements. You can select either all or individual elements for
import. Additionally, the target name can be changed.

Be sure to first select the target correctly. You can only import a project if the database is
selected. You can only import experiments and experiment templates if a project is
selected.

You can only import projects if the Project view is activated.

Export

Exports the selected entries to a file.

Whole projects and individual/multiple experiments and experiment templates can be
exported to a file.

Manually created folders are not included with the export. The exception is
a folder in the experiment path named: "Meta ".

Delete

Deletes the selected entries.

Complete projects and individual experiments/experiment templates can be deleted. If you
select delete an experiment with saved measurement data, a prompt appears for
confirmation that you wish to delete the data.

/ Show/Hide Region 2 (list of all projects) 

/ Show/Hide Region 4 (metadata information) 

Regions 2 and 3: List of all projects / experiments / experiment templates

In these two regions, the projects/the experiment and experiment templates are listed. When you select a
project, all elements of the  project selected are displayed in the region at right.

Region 2 is only displayed if the project view is activated and the region is shown (via the menu button: ).

Region 2 only shows the experiment templates if these are activated.

Region 4: Linked metadata information

The metadata saved with the selected experiment are displayed in this region. When an experiment is saved, the
metadata can be saved automatically along with it. In the Options "Metadata" > "Experiment - Metadata" >
"Setup page", you can select which source to use for the metadata.

Only shown if the region is shown (via the menu button: ).
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6.2  Creating/Saving/Copying an experiment
Each experiment has an identifying name which is specified when it is created/saved. Each name may be used
only once per project.

When you create an experiment (ribbon menu item: "Home" or "Project" > "New"), or when you save an
experiment under a new name, you are asked for a name. In this case, enter a unique name.

If the "Project view" is activated, you can additionally select the target project.

Action Description

New Experiment When you create a new experiment, it is generated from an experiment template (see
"Experiment template ").

· If experiment templates are displayed , select an experiment template.

· If they are not displayed, the preferred experiment template  is used automatically
(at default: "StandardTemplate").

All changes since the last save are discarded if a new experiment is created.

Save experiment as When you save an experiment under a new name, a new experiment having the current
settings is created.

· Measurement data from the existing experiment are not transferred along to the new
experiment (exception: if the experiment was previously never saved; in that case a
prompt appears to ask whether to include these measured data).

· Files from the folder "Meta"  are copied and are available in the new experiment.

Copying an experiment to a
different project

You can copy experiments to a different project by means either of Drag&Drop or of the
context menu. This means that all files located in the Experiment-folder are included:
Measured data, saved measurement settings, parameter set files or user-made folders of
metadata.

6.3  Experiment templates
When you create a new experiment, it is generated from an experiment template. The new experiment contains
all properties of the selected template. In templates, all settings which are saved will be saved also in an
experiment.

After the first installation or after creating a new project, the project contains an "empty" experiment template.
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Making experiment templates visible

You can activate the "Experiment templates" in the options (under "Project Management" > "General options"):

Ribbon View

Extra > Options ( ) All

Option Description

Show experiment template

In order to be able to use experiment templates, you must previously make the experiment
templates visible. This option is deactivated by default. (Information on Experiment
templates )

An extended view of certain dialogs  is available. Experiment templates can be created
and used.

Only activate this function if you wish to create multiple similar
experiments.

If this function is deactivated, some dialogs are displayed in simplified
form (e.g. "New experiment" and "Edit project" appear without
experiment template selection).

Creating experiment templates

Ensure that experiment templates are visible. You can generate experiment templates from a variety of sources:

Source Description

From present settings The configuration currently set is used for the template. (see also "Save as template ")

From existing experiment Select an experiment from which to generate the template.

From default settings An empty template is created.

· Click on the button: "Manage Projects"

Menu ribbon View

Project > Manage Project ( ) Complete

· Select the project (if the projects are not displayed, click on the white background, in order to avoid
selecting an experiment)

· In the dialog, click on the menu item: "New" > "Add experiment template"

· Select a source

The experiment template is created from the source and and is available when creating an experiment .

Preferred experiment template

You can mark an experiment template as preferred (template context menu > "Set as preferred experiment
template"). If the experiment templates are no longer displayed, the new preferred experiment template is
automatically used when a new experiment is created.
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7  Ribbon

7.1  Project menu
The "Project" menu is available in every plug-in.

Some of the dialogs offer an extended view. By default, the dialogs are displayed without "project view" and
"experiment templates".

Project

Menu item Description

Manage
Projects

Managing projects and experiment templates

Save Project Saves the current project

Experiment

Menu item Description

New Creates a new experiment

Open Opens an existing experiment

Save Saves the current experiment

Save as

Saves the current experiment under a new name.

Additionally, the experiment is reset. The variables are assigned the respective initial value
(e.g. device variables = "0", or user-defined variables are assigned the respective initial value
specified). The event "Experiment_Loaded" is triggered.

Save as template
When you click on the button, a new template  is generated which the system then uses
automatically (keyword "Preferred experiment template "). (from the edition
"imc STUDIO Professional")

Im-/Export

Menu item Description

Import / Export In this dialog you can import and export various components.

Current Measurement

Menu item Description

Save current Data

Export current Data

In addition to the optional automatic data saving, you can also perform targeted saving of
the data currently in the PC (Current measurement) either during or subsequent to the
measurement.

See also Setup pages - Configuring device: "Storage options and directory structure" >
"Controlling Data Storage" > "Targeted Data Saving, or Saving Subsequent to
Measurement"
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Note Without imc STUDIO Project Management

In the product configuration, the component "imc STUDIO Project Management" can be deactivated. If
"imc STUDIO Project Management" is deactivated, a number of limitations apply.

Among others, there is no longer any database. The dialogs for saving and opening experiments match the
standardized "Save As"- or "Open"-dialogs. Experiments can be saved at any desired location. The saved
measurement data are stored in the designated experiment folder.

The functions of the Project Management are listed in the technical data sheet.

The description of the Project- and Experiment-dialogs n the following pages pertain to imc STUDIO with
activated Project Management.

Changes in the menu without imc STUDIO Project Management:

Project - without Project Management

Menu item Description

Save Project
Saves the current project. In this case, all "Project"-settings are saved as "Application"-
settings and apply for all experiments.

Experiment - without Project Management

Menu item Description

New experiment

Creates a new experiment. The storage location is first determined by means of "Save
experiment/Save experiment as".

The device currently selected remains selected. However, the device's configuration will be
reset.

Open experiment Opens an existing experiment. The experiment can be be saved anywhere in the file system.

Save experiment
Saves the current experiment at the storage location previously set using "Save experiment
as"; if no storage location had been determined yet, "Save experiment as" is run
automatically.

Save experiment as Saves the current experiment under an arbitrary name at any location in the file system
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8  Navigation pane and Quick access toolbar

Navigations pane

Maximized Navigation Pane
(example)

In the Navigation pane, the main windows of the installed plug-ins are displayed as
a tree diagram. To open/change the main window, click on its corresponding entry.

The Navigation pane can be opened or closed, maximized and minimized.

· To maximize/minimize the Navigation pane, click in its top bar on the
arrow symbol.

· To open/close the Navigation pane, click on the upper region of it
below the arrow.

If the Navigation pane is maximized or opened, the main windows are
additionally displayed as a tree diagram (see example shown).

Via the tree diagram, it is possible to jump to different main windows or
directly to the pages containing the main windows.

You can hide the Navigation pane.

If you hide the Navigation pane, please note that your ability to navigate between
the main windows. For this case, you should add the command: "Browse
workspace" at suitable locations, for instance in the ribbon menu ("User-def ined
buttons").

To show or hide the Navigation pane use the dialog: "Tool windows chooser ".

Quick access toolbar

The "Quick access toolbar" can be supplemented with various menu items. Which actions are available for this
purpose doesn't depend on what tab is currently displayed in the menu ribbon.

Using the context menu, you can either add or remove menu actions.

· Adding: context menu of the menu item in the menu ribbon (note: the menu ribbon may not be minimized)

· Removing: context menu of the menu item in the toolbar

You may place the toolbar either above or below the menu ribbon.

Note Saving the configuration

The configuration of the "Quick access toolbar" is saved with the respective view.

The configuration is only saved whenever the project is saved.
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9  Tool windows
Tool windows contain special elements for operating/viewing a main window. (For information on operating the
tool window: "Operation ")

Five tool windows

 
- The imc STUDIO frame's log book

 
- Four additional windows from the main window imc STUDIO Panel

One tool window belongs to the imc STUDIO frame and is always available:

· Logbook

The Logbook is always displayed and can be minimized. The other main windows' tool windows (e.g. for the
Panel) are displayed as soon as the respective main window is opened.

Note Not all tool windows are visible

By default, all necessary tool windows are displayed. All others can be displayed , if you need them.

9.1  Operation

Tool windows contain special elements for operating and editing a main window.

Tool window (example)

Each main window has its own tool window, which is described in the
documentation of the respective component. Tool windows can be moved and
deleted.

By default, the tool windows are pinned to the main window (e.g. at the bottom or
right margin).

The picture shows an opened tool window ("Details"). It is pinned and contains two
additional tabs. If you click on one of these tabs, the corresponding tool window
opens ("Dependency Tree" and "Column Finder").

Three other collapsed tool windows are seen at the right margin ("Sensors",
"Layout Repository" and "Table descriptions").

A tool window is opened when the mouse is swiped over it.

As long as a tool window is selected, or if the mouse is located over the tool
window, the tool window remains open. Otherwise, it collapses to the side.
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Showing/hiding the tool window

You can either show or hide tool windows. To do this, open the dialog: "Tool Window Chooser".

Ribbon View

View > Choose Tool Windows ( ) Complete

Extra > Choose Tool Windows ( ) Standard

Dialog: Tool windows chooser

The dialog: "Tool Window Chooser" opens.

Set a checkmark in front of the tool windows which you wish to have displayed.

Selecting "More" provides you with comprehensive layouting capabilities for the
view. You are able to place any tool window belonging to other components on the
current page. For instance, you can display the Data Browser in the window of the
Automation. Or you can show the Panel in the Setup.

Other actions

Action Description

Pinning the tool window Tool windows can be pinned. Pinned tool windows remain open even when no longer
selected.

In order to pin a tool window, click on the thumbtack-button ( ).

Freely positioning the tool
window

In order to freely position the pinned tool window, move the tool window's title bar using
drag&drop to the desired position.

Docking the tool window In order to dock the tool window, use the drag&drop technique by grabbing the tool
window's by its title bar and moving it to the desired position. A Dock-symbol will appear at
the locations which are possible.

In the center of the targeted window (main window or tool window), a
cross appears. To dock the tool window, release the mouse button with the
mouse over the desired position.

Dock at the top/bottom margin

Dock at the left/right margin

Insert as a tab in a different window (see example)
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9.2  Logbook
In the tool window "Logbook", messages of the categories: "Fatal" ( ), "Error" ( ), "Warning" ( ) and
"Information" ( ) are entered. The logbook entries indicate what problems and errors exist and provide hints
on where to find them and how to remedy them. Some actions performed are documented.

E.g., a note is entered in the logbook for every command performed:

· performed successfully ("Information") or

· otherwise "Error" or "Warning"

By default, the Logbook is opened when an entry any of the categories "Fatal", "Error" or "Warning" occurs. By
default "Information" category notes are entered into the logbook without any further effect.

Example of  logbook entries

Each logbook entry consists of:

Parameter Description

Symbol for the category Fatal ( ), Error ( ), Warning ( ) and Information ( )

Time Time the logbook entry occurred

Code Logbook entry's error code

Message Exact description of the logbook entry

Sender The origin of the logbook entry

After a new imc STUDIO start, the logbook is empty. The logbook itself only displays messages which occurred
since the last start. Older messages can be opened with the "Logbook-Viewer".
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10  Views
The program's GUI is adaptable, so that for example the windows and columns can be positioned and displayed
according to the user's desires. The layout of the GUI is saved in so-called "Views". It is possible to create
separate views for various requirements.

The following settings are saved along with a view:

Region  Description

Window arrangement The imc STUDIO window's and the tool window's position and size

Menus Layout of the menu ribbon and the Quick access toolbar

Layout · The last main window opened

· The tool window's layout (e.g. what metadata columns are displayed in the
Data Browser)

· The arrangement and configuration of the Setup pages (e.g. arrangement of columns,
such as metadata columns)

Note Views and projects

The relationship between saving the view and saving the project

The views are saved with their respective project. When a view is saved, it is necessary for the project to be
saved. The system will notify the user accordingly.

Conversely, when a project is saved, the view is not automatically saved. Views are only saved whenever
the action "Save View (as)" is intentionally selected. In order to avoid every little change to a view being
saved whenever the project settings are saved, the views are ignored when specifically the project is saved.

Settings which apply globally to all views are saved with the Project

Please note that only the positions of individual elements is saved along with the views. The existence and
configuration, for instance, of the Setup-columns (tables- and column descriptions) is saved along with the
respective project. (see also "What is saved where?")

Since the project is always saved whenever the view is saved, the current configuration of the columns is
also included when saving.

Overview of settings saved with the project, which affect the views

· Setup table descriptions and column descriptions (these include, for example, additional columns, such as
metadata-columns, parameter set columns, ...) (tool window: Table Descriptions)

· saved Setup  complete layouts (tool window: Layout Repository)

Note Detecting changes to a view

If any major changes (columns added, menu changed, etc.) are made, the system explicitly recognizes this
as a change to the view. When you exit the project by switching to a different project or by closing
imc STUDIO, you are prompted to select whether to save the changes.

Minor changes, such as changed size of tool windows, are ignored.
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Saving views

In order to save the current view, select the menu item "Save View (as)":

Ribbon View

View > Save View / Save View as (  / ) Complete

Extra > Save View / Save View as (  / ) Standard

All settings belonging to the current view are saved. These include the items named above.

Note The views are saved with the project

The views are saved with their respective project. When a view is saved, it is necessary for the project to be
saved. The system will notify the user accordingly.

Loading views

In order to load a saved view, select the menu item "View" in the drop-down list of the respective view. Here, all
views available to the project are displayed.

After the selection the view is loaded.

The record of an experiment includes the view in which the experiment was saved. When the experiment is
loaded, the view also loads automatically.

Deleting views

To delete a saved view, select the menu item "Delete View".

Ribbon View

View > Delete View ( ) Complete

Extra > Delete View ( ) Standard

In the dialog which then opens, select the view to delete from the drop-down list. Confirm your selection by
clicking on "Save project".

Restoring views

Views are not write-protected. They can be restored to their original state. The factory settings come with a
copy of all views created as part of the program installation.

To restore a view from the factory settings, select the menu item "Restore".

Ribbon View

View > Restore ( ) Complete

Extra > Restore ( ) Standard

In the dialog which then opens, select the desired views. They are imported from the factory settings. Conform
your selection by clicking on "OK".
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10.1  Exporting/importing views
When you export the view settings, a variety of project settings are stored in the export file.

Settings Description

Saved views · table descriptions and column descriptions (these include, for example, additional
columns, such as "metadata columns", "parameter set columns", ...)
(tool window: "Table Descriptions")

· saved complete layouts (tool window: "Layout Repository")

Sensors · user-defined characteristic curves/sensors (tool window: "Sensors")

Export of views, metadata columns, sensors, ...

By means of the menu item "Import/Export", you can export the view settings:

Ribbon View

Project > Import/Export ( ) Complete

Extra > Import/Export ( ) Standard

· Choose option "Export" and then the list item "Export views, meta data columns, sensors, ..."

· Choose an appropriate file name and path for the view settings file

Note Save the view beforehand

Save the view beforehand if you have made any changes (see "Views ").

Import of views, metadata columns, ...

Using the menu item "Import/Export", you can import the view settings to the current project:

Ribbon View

Project > Import/Export ( ) Complete

Extra > Import/Export ( ) Standard

· Choose option "Import" and then the list item "Import views, meta data columns, ..."

· In the file selection dialog, selected the saved view settings file
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Thereafter you will see a dialog allowing you to import either all or individual view settings.

Entries having colored shading already exist in the current project. In this example, the complete layout "New
Page" is not yet present there.

Checkbox Description

Selected (left) Check this box if you wish to import the element.

Overwrite? (right) Check this box if the element in the project is to be overwritten without any confirmation
prompt. If the box is not check-marked, a prompt appears to inquire the name for the
element to be imported. (Unless "Replace all items selected" is check-marked.)

Replace all items selected Corresponds to "Overwrite?" for all entries: Check this box if you want to replace all
elements without any confirmation prompt.

You can select the following elements:

Element Description

Layouts All these elements belong to the Setup pages. Saved pages and saved designs, which can be
displayed on the pages. For more information on the complete layouts, see the chapter:
"Table Description and Complete Layout".

Views Her you find the imc STUDIO-views. The views  apply for all components of imc STUDIO.

Note New functions can be overwritten

Be aware that when making replacements, new functions may be lost if you import old views/columns.
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Importing defined additional columns

An additional prompt appears if

· discrepancies between existing Setup columns were detected or

· the file contains additional columns.

Select which columns to import and/or any to replace.

If the column already exists, a checkbox appears under "Overwrite?". If the box is not check-marked, the column
is automatically renamed. You can edit the name afterward. For more information, see the chapter: "Creating
and conf iguring additional columns".
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Address

imc Test & Measurement GmbH
Voltastr. 5
13355 Berlin

Phone: (Germany): +49 30 467090-0

E-Mail: info@imc-tm.de

Internet: https://www.imc-tm.com

Tech support

If you have problems or questions, please contact our tech support:

Phone: (Germany): +49 30 467090-26

E-Mail: hotline@imc-tm.de

Internet: https://www.imc-tm.com/service-training/

Service and maintenance

Our service team is at your disposal for service and maintenance inquiries:

Phone: (Germany): +49 30 629396-333

E-Mail: service@imc-tm.de

Internet: https://www.imc-tm.com/service

imc ACADEMY - Training center

The safe handling of measurement devices requires a good knowledge of the system. At our training center,
experienced specialists are here to share their knowledge.

E-Mail: schulung@imc-tm.de

Internet: https://www.imc-tm.com/service-training/imc-academy

International partners

You will find the contact person responsible for you in our overview list of imc partners:

Internet: https://www.imc-tm.com/imc-worldwide/

imc @ Social Media

https://www.facebook.com/imcTestMeasurement

https://www.youtube.com/c/imcTestMeasurementGmbH

https://x.com/imc_de

https://www.linkedin.com/company/imc-test-&-measurement-gmbh
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